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Thank you for purchasing this product. FLIR is committed to providing our customers with a high quality,
reliable security solution.

This manual refers to the following models:

DNR408 (8-channel)

DNR416 (16-channel)

For the latest online manual, downloads and product updates, and to learn about our complete line of
accessory products, please visit our website at:

www.flirsecurity.com/pro

WARNING
RISKOF ELECTRIC SHOCK
DO NOTOPEN

WARNING: TO REDUCE THE RISK OF ELECTRIC SHOCK DO NOT REMOVE
COVER. NO USER SERVICEABLE PARTS INSIDE.

REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral
triangle, is intended to alert the user to the presence of uninsulated
"dangerous voltage" within the product’s enclosure that may be of
sufficient magnitude to constitute a risk of electric shock.

The exclamation point within an equilateral triangle is intended to
alert the user to the presence of important operating and
maintenance (servicing) instructions in the literature accompanying
the appliance.

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS
UNIT TO RAIN OR MOISTURE.

CAUTION: TO PREVENT ELECTRIC SHOCK, MATCHWIDE BLADE OF THE PLUG
TO THEWIDE SLOTAND FULLY INSERT.
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Important Safeguards1

In addition to the careful attention devoted to quality standards in the manufacturing
process of your product, safety is a major factor in the design of every instrument. How-
ever, safety is your responsibility too. This sheet lists important information that will help
to ensure your enjoyment and proper use of the product and accessory equipment.
Please read them carefully before operating and using your product.

1.1 General Precautions

1. All warnings and instructions in this manual should be followed.
2. Remove the plug from the outlet before cleaning. Do not use liquid aerosol deter-

gents. Use a water-dampened cloth for cleaning.
3. Do not use this product in humid or wet places.
4. Keep enough space around the product for ventilation. Slots and openings in the

storage cabinet should not be blocked.
5. It is highly recommended to connect the product to a surge protector to protect from

damage caused by electrical surges. It is also recommended to connect the product
to an uninterruptible power supply (UPS), which has an internal battery that will keep
the product running in the event of a power outage.

CAUTION

Maintain electrical safety. Power line operated equipment or accessories connected to this product
should bear the UL listing mark or CSA certification mark on the accessory itself and should not be
modified so as to defeat the safety features. This will help avoid any potential hazard from electrical
shock or fire. If in doubt, contact qualified service personnel.

1.2 Installation

1. Read and Follow Instructions - All the safety and operating instructions should be
read before the product is operated. Follow all operating instructions.

2. Retain Instructions - The safety and operating instructions should be retained for
future reference.

3. Heed Warnings - Comply with all warnings on the product and in the operating
instructions.

4. Polarization - Do not defeat the safety purpose of the polarized or grounding-type
plug.
A polarized plug has two blades with one wider than the other.

A grounding type plug has two blades and a third grounding prong.

The wide blade or the third prong are provided for your safety.

If the provided plug does not fit into your outlet, consult an electrician for replacement
of the obsolete outlet.

5. Power Sources - This product should be operated only from the type of power
source indicated on the marking label. If you are not sure of the type of power sup-
plied to your location, consult your video dealer or local power company. For products
intended to operate from battery power, or other sources, refer to the operating
instructions.
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Important Safeguards1

6. Overloading - Do not overload wall outlets or extension cords as this can result in
the risk of fire or electric shock. Overloaded AC outlets, extension cords, frayed
power cords, damaged or cracked wire insulation, and broken plugs are dangerous.
They may result in a shock or fire hazard. Periodically examine the cord, and if its ap-
pearance indicates damage or deteriorated insulation, have it replaced by your serv-
ice technician.

7. Power-Cord Protection - Power supply cords should be routed so that they are not
likely to be walked on or pinched by items placed upon or against them. Pay particu-
lar attention to cords at plugs, convenience receptacles, and the point where they exit
from the product.

8. Surge Protectors - It is highly recommended that the product be connected to a
surge protector. Doing so will protect the product from damage caused by power
surges. Surge protectors should bear the UL listing mark or CSA certification mark.

9. Uninterruptible Power Supplies (UPS) - Because this product is designed for con-
tinuous, 24/7 operation, it is recommended that you connect the product to an unin-
terruptible power supply. An uninterruptible power supply has an internal battery that
will keep the product running in the event of a power outage. Uninterruptible power
supplies should bear the UL listing mark or CSA certification mark.

10.Ventilation - Slots and openings in the case are provided for ventilation to ensure re-
liable operation of the product and to protect it from overheating. These openings
must not be blocked or covered. The openings should never be blocked by placing
the product on a bed, sofa, rug, or other similar surface. This product should never
be placed near or over a radiator or heat register. This product should not be placed
in a built-in installation such as a bookcase or rack unless proper ventilation is pro-
vided and the product manufacturer’s instructions have been followed.

11.Attachments - Do not use attachments unless recommended by the product manu-
facturer as they may cause a hazard.

12.Water and Moisture - Do not use this product near water — for example, near a bath
tub, wash bowl, kitchen sink or laundry tub, in a wet basement, near a swimming pool
and the like.

13.Heat - The product should be situated away from heat sources such as radiators,
heat registers, stoves, or other products (including amplifiers) that produce heat.

14.Accessories - Do not place this product on an unstable cart, stand, tripod, or table.
The product may fall, causing serious damage to the product. Use this product only
with a cart, stand, tripod, bracket, or table recommended by the manufacturer or sold
with the product. Any mounting of the product should follow the manufacturer’s in-
structions and use a mounting accessory recommended by the manufacturer.

15.Camera Extension Cables – Check the rating of your extension cable(s) to verify
compliance with your local authority regulations prior to installation.

16.Mounting - The cameras provided with this system should be mounted only as in-
structed in this guide or the instructions that came with your cameras, using the pro-
vided mounting brackets.

17.Camera Installation - Cameras are not intended for submersion in water. Not all
cameras can be installed outdoors. Check your camera environmental rating to con-
firm if they can be installed outdoors. When installing cameras outdoors, installation
in a sheltered area is required.

1.3 Service

1. Servicing - Do not attempt to service this product yourself, as opening or removing
covers may expose you to dangerous voltage or other hazards. Refer all servicing to
qualified service personnel.
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Important Safeguards1

2. Conditions Requiring Service - Unplug this product from the wall outlet and refer
servicing to qualified service personnel under the following conditions:

• When the power supply cord or plug is damaged.
• If liquid has been spilled or objects have fallen into the product.
• If the product has been exposed to rain or water.
• If the product has been dropped or the cabinet has been damaged
• If the product does not operate normally by following the operating instructions.
Adjust only those controls that are covered by the operating instructions. Improper
adjustment of other controls may result in damage and will often require extensive
work by a qualified technician to restore the product to its normal operation.

• When the product exhibits a distinct change in performance. This indicates a need
for service.

3. Replacement Parts -When replacement parts are required, have the service techni-
cian verify that the replacements used have the same safety characteristics as the
original parts. Use of replacements specified by the product manufacturer can pre-
vent fire, electric shock, or other hazards.

4. Safety Check - Upon completion of any service or repairs to this product, ask the
service technician to perform safety checks recommended by the manufacturer to
determine that the product is in safe operating condition.

1.4 Use

1. Cleaning - Unplug the product from the wall outlet before cleaning. Do not use liquid
cleaners or aerosol cleaners. Use a damp cloth for cleaning.

2. Product and Cart Combination -When product is installed on a cart, product and
cart combination should be moved with care. Quick stops, excessive force, and un-
even surfaces may cause the product and cart combination to overturn.

3. Object and Liquid Entry - Never push objects of any kind into this product through
openings as they may touch dangerous voltage points or “short-out” parts that could
result in a fire or electric shock. Never spill liquid of any kind on the product.

4. Lightning - For added protection of this product during a lightning storm, or when it
is left unattended and unused for long periods of time, unplug it from the wall outlet
and disconnect the antenna or cable system. This will prevent damage to the product
due to lightning and power line surges.
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DNR400 Series Features2

Features

• Easy Connection and setup with 8 integrated PoE+ ports and auto-discovery of IP
Cameras

• Full HD 1080P recording provides the most detailed picture and reliable identification
with selectable area digital zoom

• 120watt total PoE supports PoE+ (25watt max per camera)
• Real-time recording in full HD per channel with cameras up to 5MP
• 200Mbps network bit rate (supports 48-8192kbps per camera)
• Dual streaming (H.264/MJPEG)
• Pentaplex operation - simultaneous View, Record, Playback, Backup & Remote
Monitoring

• ONVIF 2.3 conformance ensures compatibility with popular industry IP cameras
• Supports up to 5MP camera resolution
• FLIR Cloud Quick & Secure Connect via QR code scan
• HDMI / VGA simultaneous video output
• FLIR secure DDNS service
• RS-485 supports Pelco D & P PTZ
• Audio I/O: 1 in - 1 out, Alarm I/O: 4 in - 2 out
• Supports 2x SATA HDDs up to 4TB (8TB total), 2x USB 2.0 ports
• Drive mirroring to second internal HDD
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Getting Started (DNR400 Series)3

The system comes with the following components:

NVR (Network Video Recorder) AC power cable Remote control
(may not be exactly as shown)

USB mouse Ethernet cable Quick start guides & software
CD

Hard drive size, number of channels, and camera configuration may vary by model.
Please refer to your package for specific details. Check your package to confirm that you
have received the complete system, including all components shown above.
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DNR400 Series Front Panel4

1. USB Port: Connect a USB mouse (included) or connect a USB flash drive (not in-
cluded) for data backup or firmware upgrades.

2. IR: Not supported.
3. Channel Indicators: Glow when camera is connected to the corresponding channel.

4. Playback Controls:

• Pause/Play: In live view, press to enter playback mode. Press to play/pause
playback.

• Reverse: Press to reverse playback/pause playback.

• Fast: Press to increase playback speed.

• Next: Press to skip to next video.

• Previous: Press to skip to previous video.

• Slow: Press for slow playback.

5. Function Buttons:

• REC: Press to open manual recording controls.
• FN: Performs special functions in some menus.
• SHIFT: During text input, press to switch input types.
• ESC: In menus, press to go back / exit menus. In playback, press to return to live
view.

6. Directional Buttons:

• ENTER: From live view, press once to open the System Information screen; press
twice to open the Main Menu. In menus, press to confirm menu options.

• Directional Buttons: Press to move cursor in menus. In live view, press up to
change split screen layout; press left / right to select channels when single-chan-
nel mode is selected.

7. Power Button: Press and hold to power off the system. Press to power the system
back on.

8. IR Receiver and LED Indicators: IR receiver for the remote control. Keep the IR re-
ceiver clear from obstructions.
LED Indicators:

• POWER: Glows to indicate the system is on.
• HDD: Glows to indicate hard drive is in normal state. Turns off when there is a hard
drive error.

• NET: Glows when network is in normal state. Turns off for network error.
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Rear Panel (DNR400 Series)5

1. Power input: Connect the included AC power cable.
2. On / Off switch: Turns the NVR on or off.
3. PoE Ports: Connect IP cameras. Integrated PoE (Power Over Ethernet) ports provide

power to cameras and video connection to NVR.
4. LAN: Connect a CAT 5 RJ45 Ethernet cable for local and remote connectivity.
5. VGA: Connect a VGA monitor (not included) to view the system interface.
6. MIC IN/OUT: RCA input and output for 2–way audio.

NOTE

Audio-enabled IP cameras (not included) are required to use audio recording. You cannot record
audio from the input (e.g. microphone) connected to the MIC IN port.

7. HDMI: Connect to an HDMI monitor or TV (not included) to view the system interface.
8. RS232: Service only; not supported.
9. USB port(s): Connect a USB mouse (included) or USB thumb drive (not included)

for data backup or firmware updates.
10.Alarm block: Connect alarm/sensor devices (not included).

#LX400022; r.16694/30364; en-US 7



Basic Setup (DNR400 Series)6

6.1 Step 1: Connect the IP Cameras

Option 1: Direct Connection to NVR

• Connect cameras to the PoE Ports on the rear panel of the NVR using Cat5e or high-
er grade Ethernet cable. The cameras will appear on the NVR without any additional
configuration when the system starts up.

Connect IP cameras directly to PoE ports.

Option 2: Connect Cameras to Local Network

You can also connect your IP cameras to your local network for flexible installations. For
details, see 6.11 Connecting Cameras to the Local Area Network (LAN), page 11.

6.2 Step 2: Connect the Mouse

• Connect a USB mouse (included) to one of the USB ports.

6.3 Step 3: Connect the Ethernet Cable

• Connect an Ethernet cable (included) to the LAN port on the rear panel of the system.
Connect the other end of the Ethernet cable to a router on your network.

6.4 Step 4: Connect the Monitor

• Connect the included HDMI cable from the HDMI port to the TVor monitor
(recommended).
OR
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Basic Setup (DNR400 Series)6

• Connect a VGA cable (not included) from the VGA port to the monitor.

1. VGA port.
2. HDMI port.

6.5 Step 5: Connect the Power Cable to Power the NVR

• Connect the included AC power cable to the NVR and connect the other end to a
power outlet or surge protector. Then turn the power switch to l to power on the NVR.

At startup, the system performs a basic system check and runs an initial loading se-
quence. After a few moments, the system loads a live display view.

6.6 Step 6: Upgrade Firmware to Latest Version (if Available)

If a firmware upgrade is available, you will be asked to install it once the system starts up.
It is required to upgrade your system firmware and client software or mobile apps to the
latest version to enable remote connection to the system.

If a firmware upgrade is available:

1. After startup, a notification will appear asking you to upgrade the firmware. Click OK
to upgrade.

2. Enter the system user name (default: admin) and password (default: 000000) and
click OK. Wait for the firmware update to complete. The system will restart once the
firmware has been upgraded.

WARNING

DO NOT POWER OFF THE SYSTEM OR DISCONNECT THE POWER CABLE DURING FIRM-
WARE INSTALLATION

6.7 Step 7: Verify Camera Image

• Power on the cameras, and then verify the camera video quality before mounting the
cameras to a permanent location.

• Mount the cameras under a sheltered location. Always verify the outdoor rating of your
camera before installing it in a permanent location.

6.8 Step 8: Set the Time

• Set the system time and date for accurate video time stamps. Videos with inaccurate
times may not be valid as surveillance evidence.

• For details on setting the system time, see 10 Setting The Time, page 23.
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Basic Setup (DNR400 Series)6

6.9 Default System Password & Port Numbers

CAUTION

By default, the system user name is admin and the password is 000000. It is essential that you create
your own password. For details, see 14Managing Passwords and User Accounts, page 37.

The system requires a user name and password to log in to the system remotely using a
computer or mobile device. After logging on remotely the first time, you will be asked to
create a custom password for the system.

Local system and remote connectivity (LAN & Internet) user name and password:

• Username: admin
• Password: 000000

Default ports for DDNS remote access:

• Port 80 (HTTP port)
• Port 35000 (Client port)

6.9.1 FLIR Cloud™

This system features the exclusive FLIR Cloud™. This is a cloud service that allows you
to connect to your system over the Internet via a secure handshake with our servers. This
means you can easily connect to your system without requiring any network
configuration.

For details on setting up your system to connect to the Internet using FLIR
Cloud™:

• See 16 Connecting to Your System Over the Internet on PC or Mac, page 72.
OR

• See 18 Connecting to your System Using Smartphone or Tablet Apps, page 100.

Connectivity using FLIR’s free DDNS service is also available, but requires the ports
listed above to be port forwarded on your router.

6.10 Quick Access to System Information

To quickly open a window that displays vital system information:

• Right-click to open the Quick Menu and click Info. Enter the system user name (de-
fault: admin) and password (default: 000000).
OR

• Press the ENTER button on the front panel.
OR

• Press the ENTER button on the remote control.

NOTE

The QR code shown in the System Info screen can be scanned during mobile setup to enter the sys-
tem’s Device ID.
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6.11 Connecting Cameras to the Local Area Network (LAN)

For flexibility, you may also connect IP cameras to the same Local Area Network (LAN)
as the NVR. This is accomplished by connecting the cameras to the same router as the
NVR.

For these installations, an external PoE switch (sold separately) or power adapter (sold
separately) must be used to provide power to each IP camera. You also must add the
cameras on the NVR before they will show a picture on the monitor or be recorded by
the NVR.

Follow the steps below to connect the cameras to the NVR over the LAN.

NOTE

• For a list of 3rd party IP cameras supported, please visit www.flirsecurity.com/pro.
• Camera and NVR images in this section are used for illustration only.

Step 1 of 2 — Option A: Connecting cameras to your local network using a PoE
switch:

1. Connect an Ethernet cable from the LAN port on an external PoE switch (sold sepa-
rately on www.flirsecurity.com/pro) to your router using a CAT5e or higher Ethernet
cable. Connect the power cable to the PoE swtich and to a power outlet or surge
protector.

NOTE

Terminology may vary depending on the model of PoE switch you have.

2. Connect the IP cameras to the PoE switch using the Ethernet extension cables. The
PoE switch will provide power and video transmission the same way as your NVR.
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Step 1 of 2 — Option B: Connecting cameras to your local network using power
adapters:

1. Connect each camera to a compatible power adapter (visit www.flirsecurity.com/pro
for compatible power adapters for your cameras).

2. Connect the camera to your router using a CAT5e or higher Ethernet cable.

Step 2 of 2: Add the cameras to your NVR:

1. Right-click and select Device Search .
2. Log in using the admin account (default User Name: admin; default Password:

000000).
3. Click Device Search. The system searches the network for compatible cameras.

4. Check the camera(s) you would like to add.
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5. Click Add. The Status indicator turns green to show the camera is successfully
connected.

NOTE

If the Status indicator is red, click and update the info for your IP camera. Click OK to save
changes.

6. Click OK to save changes.

NOTE

You can also add a camera to a specific channel by hovering the mouse over an empty channel in split-

screen view and clicking . Then double-click the camera you would like to add and right click to exit.
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The mouse is the primary control device for the system. To connect a USB mouse:

• Connect a USB mouse to the USB port on the front or rear panel.

1. Left-button:

• In live view, click to open the Navigation Bar. Right-click to close the navigation
bar.

• In live view, while in a split-screen display mode, double-click an individual chan-
nel to view it in full-screen. Double-click again to return to the split-screen display
mode.

• While navigating menus, click to open a menu option.

2. Right-button:

• During live view, right-click anywhere on the screen to open the Quick Menu.
• Within system menus, right-click to exit menus.

3. Scroll wheel: In live view, use the scroll wheel to zoom in/out.

#LX400022; r.16694/30364; en-US 14



Remote Control8

1. Power: Press and hold to power off the system. Press to power on.

2. Playback controls:

• Pause/Play: In live view, press to enter playback mode. Press to play/pause
playback.

• Reverse: Press to reverse playback/pause playback.

• Fast: Press to increase playback speed.

• Next: Press to skip to next video.

• Previous: Press to skip to previous video.

• Slow: Press for slow playback.

3. Esc: In menus, press to go back / exit menus. In playback, press to return to live view.

4. Directional keys:

• Enter: Press once to open the System Information screen; press twice to open
the Navigation Bar. Press to confirm menu selections.

• Press to move the menu cursor.

• Press to change menu options.

5. Mult: Press to switch between full-screen and split-screen layouts.
6. Number keys:

• 1~0: In live view, press to open channels in full-screen.
• In menus, press to input numbers or text input.
• Shift: Press to change input types.

7. Add: Configure remote control address. See below for details.
8. Rec: Press to open manual record menu.
9. Fn: Press to perform special functions in some menus.

8.1 Setting the Remote Control Address

If you have more than one system, you can set up your remote control to pair with a spe-
cific system.
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To set the remote control address:

1. Right-click and click Main Menu. Enter the system user name (default: admin) and
password (default: 000000).

2. Click and then click Setting>General>General.

3. Under Device No., enter the address number you would like to assign to the remote
control.

4. Click OK.
5. Using the remote control, press Add. Then enter the address number and press

Enter.

NOTE

When entering the address number using the remote, make sure that you press three digits. A sin-
gle-digit number should be preceded by two zeros. A two-digit number should be preceded by one
zero. For example, if you entered 8 as the Device No., you have to press Add then 008 on the
remote.
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Use the system’s graphical on-screen display to navigate menus and configure options
and settings.

NOTE

Up to four channels at a time may be viewed using the system’s high definition Main Stream. If more
than four channels need to be viewed, additional channels will be displayed using the lower resolution
Sub Stream. Although the live display picture will not be as sharp on these channels, all channels will
still be recorded in high definition by default.

9.1 On-Screen Display

The system shows the following for all display views:

1. Display area:

• Double-click on a channel to view in full-screen; double-click again to return to split
screen.

• Right-click to open the Quick Menu.
• Left-click to open the Navigation Bar.
• Move the mouse to the top of a channel to view the Camera Toolbar.
• Click-and-drag cameras to rearrange the channel display. This does not affect the
channels each camera is connected or recording to.

2. Channel name
3. C: Camera is continuously recording.
4. M: Motion has been detected.
5. Date & time: Current system date and time. For details on setting the date and time,

see 10 Setting The Time, page 23.

#LX400022; r.16694/30364; en-US 17



Using the System9

9.2 Using the Quick Menu

The Quick menu gives you access to the system’s key functions. To access the Quick
Menu, right-click the screen during live view.

The Quick Menu has the following options:

• View: Select a camera in full-screen or select a multi-channel display.
• Pan/Tilt/Zoom: Access controls for PTZ cameras (not included).
• AutoFocus: Access zoom/focus controls for auto-focus cameras (not included).
• Color Setting: Configure image settings for cameras.
• Info: Opens the system information window.

• Sequence: Click to start/stop sequence mode.
In sequence mode, the system will automatically cycle through connected cameras

every few seconds. A will appear to show that sequence mode is on.

Click the icon to pause sequence mode on the channel that is currently shown (icon

changes to ). Click again to resume sequence mode.

Right-click and select Sequence to return to normal viewing mode.

• Search: Search/playback recorded video. See 12 Search (Playback), page 26.
• Manual Control: Click Record to open the Record menu to select manual recording
options. See 11.3 Setting up Scheduled or Manual Recording, page 24. Click Alarm
Output to control alarm ouput devices (not included).

• Device Search: Open the Device Search menu to manage IP cameras over the local
network.

• Main Menu: Open the Main Menu. See 15 Using the Main Menu, page 41.

9.3 Adjusting Camera Image Settings

Use the Camera menu to adjust image settings for your cameras.

To adjust image settings:

1. Right-click on the channel you would like to configure and select Camera Setting.
Enter the system password if prompted.
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2. Configure the following settings as needed:

NOTE

The settings listed below are only shown if they are supported on the selected camera. Some cam-
era models do not support all settings.

• Mirror: Select Enable to flip the image horizontally.
• Flip: Select Flip 180° to flip the image vertically, or select No Flip for the default
orientation.

• 3D Denoise: Select Enable to turn on the camera’s noise reduction feature. Noise
reduction will ensure a cleaner image, especially at night, and may reduce the
amount of disk space required to store video.

• BLC Mode: Select High or Low to enable back light compensation or Off to dis-
able. Back light compensation adjusts the lighting levels in the picture so you can
see objects in the foreground if there is a strong light source behind them.

• Scene Mode: The Scene Mode allows you to adjust white balance levels for the
camera. Select Schedule for the camera to automatically adjust the white bal-
ance. Select Sunny or Night to use preset white balance levels. Select Custom-
ized to manually set blue and red levels.

• DayLight: This setting sets the camera’s day/night mode. Select Colorful for the
camera to use color mode at all times. Select Schedule for the camera to auto-
matically determine whether to use color or black and white mode. Select Black&-
White for the camera to use black and white mode at all times.

NOTE

It is recommended to select Schedule mode, as using Colorful may impact the camera’s per-
formance at night.

• Saturation: Adjust the vibrancy of colors in the image.
• Hue: Adjust the color hue of the image.
• Brightness: Adjust the image brightness.
• Contrast: Adjust the image contrast.

3. Click OK to save changes.

NOTE

You must save changes to apply settings changes. It is recommended to adjust one setting at a
time so you can see the results of each change. Click Default to reset the camera to default image
settings.

9.4 Using the Navigation Bar

The Navigation Bar gives quick access to certain functions and menus.
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To open the Navigation bar:

• Left click on the screen to open the Navigation Bar. The Navigation Bar has the follow-
ing options:

1. Main Menu.
2. Collapse.
3. Select display layout.
4. Sequence: Click to start/stop sequence mode.
5. PTZ: Click to open PTZ controls.
6. Camera: Click to open camera image settings.
7. Search: Search and playback recorded video. See 17.4 Playback, page 83.
8. Alarm Status: View alarms in progress. See 15.2.4 Event Info, page 48.
9. Channel Info: Click to access status information about connected cameras.
10.Device Search: Manage IP cameras over the network.
11.Network: Configure network settings for your system. See 15.3.1 Network, page

51.
12.HDD Manager: Manage hard drives connected to the system. See 15.3.19 For-

matting the Hard Drive, page 63.
13.USB Manager: Click to access options for connected USB thumb drives (not in-

cluded). You can backup video, logs, or system configurations and install firmware
upgrades.

14.System Upgrade: Check for firmware upgrades. The system must be connected
to the Internet to check for or receive updates.

9.5 Using the Camera Toolbar

The Camera Toolbar is used to perform actions on a specific channel.

To access the Camera Toolbar:

• Move the mouse to the top of the channel display. The Camera Toolbar has the follow-
ing options:

1. Quick Playback.
2. Digital zoom.
3. Real-time backup.
4. Snapshot.
5. 2–way audio.
6. Device Search.

9.5.1 Using Quick Playback

Quick Playback is used to playback the last 5~60 minutes of video from the selected
channel. You can also access Quick Playback in split-screen mode, while still viewing
live video from the other channels.
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To use Quick Playback:

1. Move your mouse to the top of the channel display and click .

NOTE

By default, the system will begin playback from 5 minutes ago. You can increase this to up to 60 mi-
nutes using the Instant Playback setting inMain Menu>Setting>General.

2. Right-click to exit Quick Playback.

9.5.2 Using Digital Zoom in Live Display

1. Move your mouse to the top of the channel display and click to activate digital
zoom. A check mark will appear in the icon to indicate digital zoom is activated

.

NOTE

You may activate digital zoom in multiple channels at the same time.

2. Click and drag inside the channel to zoom in.

• Click and drag to pan the zoom area.
• Right-click to zoom out and select a new zoom area.

• Click to disable digital zoom. Note that the channel will remain at the same
zoom level until you right-click inside it.

9.5.3 Using Real-time Backup

Real-time backup allows you to save footage from the live display to a USB thumb drive
(not included) or external hard drive (not included).

To use Real-time Backup:

1. Insert the USB thumb drive or external hard drive into one of the USB ports on the
system.

2. Move your mouse to the top of the channel display and click to start Real-time
Backup.

3. Click again to end Real-time Backup. The file is saved to your USB device.

NOTE

If the system prompts you to log in, you will need to click again to start Real-time Backup after
logging in.

9.6 Using the Virtual Keyboard

The Virtual Keyboard is used to input text or numeric values in certain menus.
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1. Backspace.
2. Enter capital letters.
3. Confirm entry.

9.7 Adjusting Camera Zoom & Focus

Auto-focus cameras (not included) have a motorized lens. The motorized lens allows you
to control the zoom and focus settings using the menus on your system.

To adjust the camera’s zoom focus:

1. Double-click on the channel where the motorized lens camera is connected.
2. Right-click and then click AutoFocus. Log into the system using the admin account

(default user name is admin and password is 000000).
3. Adjust the zoom and focus using the following options:

• Use the sliders to adjust the Zoom or Focus settings for the camera.

NOTE

Hover the mouse over the sliders and use the mouse wheel to adjust by 1% at a time.

• Click the AutoFocus button to automatically focus the camera at the current zoom
level.

• Click Default to return the camera to the default zoom and focus levels.
• Click Refresh to refresh the settings shown on the system if someone has used the
manual lens controls on the camera.

4. Right-click to exit and save changes.
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CAUTION

It is highly recommended to set the date and time when first setting up your system.

Inaccurate time stamps may render your footage unusable for court evidence.

To set the date and time:

1. In the main viewing mode, right-click and clickMain Menu.
2. Log in using the system user name (default: admin) and password (default: 000000).

3. Click and select Setting. Click General and select the Date&Time tab.

4. Under System Time, enter the current time and select your time zone. Then, click
OK.

5. Check the DSTcheck box to enable auto Daylight Savings Time updates.

NOTE

• You can adjust the Start Time and End Time for Daylights Savings Time if the default settings
do not match your region.

• Under DST Type, select Day of Week to set the start and end time based on a day and week (e.
g. 2nd Sunday in March), or select Date to set the start and end time to a specific date.

6. (Optional) Check the NTP check box to sync your system with an Internet time server.
ClickManual Update to instantly update the time.

NOTE

• Your system must have a constant connection to the Internet to use NTP.
• (Advanced) You can enter a custom NTP server under Server IP and Port, and you can select

how often the system will sync the time using Interval.

7. Click Apply to save changes.

#LX400022; r.16694/30364; en-US 23



Recording11

By default, the system is set to immediately record video from connected cameras con-
tinuously, 24 hours a day. You can customize the recording settings according to your
needs.

11.1 Video Recording Types

The system supports the following recording types.

• Recording—Continuous: Normal, continuous recording. A icon is shown when
recording is in progress.

• Recording—Motion: The system records when motion is detected by the camera.

An icon is shown when motion is detected.

11.2 Main Stream and Sub Stream

The system employs two video recording streams, a Main Stream and a Sub Stream.
Both Main Stream and Sub Stream recording are enabled by default.

The Main Stream records high quality video to your system’s hard drive.

The Sub Stream records lower resolution video for efficient streaming to devices over
the Internet. Sub Stream recording must be enabled to view video recordings on a com-
puter or mobile device.

You can configure the video quality parameters for the Main Stream or Sub Stream. For
details, see 15.1.6 Configuring Recording Quality, page 43.

11.3 Setting up Scheduled or Manual Recording

You can set the system to record based on a schedule or you can manually turn record-
ing on and off. By default, the system is set to record on an always on recording
schedule.

To configure the recording schedule, see 15.3.15 Configuring the Video Recording
Schedule, page 60.

To select between scheduled and manual recording:

1. Right-click and then selectManual>Record.

2. UnderMain Stream, select how the system will record the Main Stream for each
channel.

• Schedule: Main Stream Recording will follow the recording schedule.
• Manual: The system will record the Main Stream continuously as long as this op-
tion is checked.

• Stop: The system will not record the Main Stream for this channel. This option is
not recommended.
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3. Under Sub Stream, select how the system will record the Sub Stream for each
channel.

• Schedule: Sub Stream Recording will follow the recording schedule.
• Manual: The system will record the Sub Stream continuously as long as this op-
tion is checked.

• Stop: The system will not record the Sub Stream for this channel.

4. Under Snapshot, select Enable to enable snapshot recording on each channel. Or,
select Disable to disable snapshot recording.

5. Click OK to save changes.

11.4 Configuring Hard Drive Overwrite

When the hard drive is full, the system will overwrite the oldest recordings by default.
This is recommended, as it makes sure that your system will continue to record without
any input from you. You can also set the system to stop recording once the hard drive is
full.

To configure hard drive overwrite:

1. Right-click and selectMain Menu. Click > Setting>General>General.

2. Under HDD Full, select Overwrite for the system to overwrite the oldest recordings
when the hard drive is full. Or, select Stop Record for the system to stop recording
when the hard drive is full.

3. Click OK to save changes.
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Search mode is used to navigate and playback recorded video files on the system.

12.1 Playing Back Video from the Hard Drive

1. From live view, right-click and then click Search.
2. Log in using the system user name (default: admin) and password (default: 000000).

3. Configure the following:

3.1. Use the calendar on the right to select the day to playback.

3.2. Use the drop-down menus to select the channels you would like to playback.

NOTE

Click the display options ( ) to playback multiple channels simultaneously.

3.3. Click inside the video bar to select the playback time. The system will begin
playing back at the selected time.
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12.2 Playback Controls

1. Select playback device.
2. Calendar: Select the day to playback.
3. Channel select: Select channels to playback.
4. Video clip backup: Select video clip start and end times.
5. Backup video clip: Click to save selected clip.
6. Playback Bar: Click inside the bar to select a playback time.
7. Zoom Playback Bar: Select scope of time bar.
8. Recording types: Click to show/hide recording types.
9. Speed up
10.Slow
11.Previous/next frame
12.Play backward
13.Stop
14.Play

12.3 Playing Back from a USB Drive

If you have video files saved to a USB thumb drive (not included) or external hard drive
(not included), you can play them back using the system.

To play back from a USB drive:

1. Connect the USB thumb drive (not included) or USB external hard drive (not in-
cluded) with video files on it into a USB port on the system.

2. From live view, right-click and click Search.
3. Log in using the system user name (default: admin) and password (default: 000000).
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4. Click From ReadWrite Hdd and select From IO Device. Click Browse to open the
USB drive and manually select the video file.

5. Double click the video file you would like to open.

12.4 Using Smart Search

Smart Search makes it easy to review motion events in specific zones of your video
stream. Select the areas that interest you and Smart Search plays your recording from
the time when your camera detects motion in those areas. To set up smart search:

1. In the multiple-channel playback mode, double-click a channel and then click the

Smart Search icon ( ).
2. To create a Smart Search zone, left-click and select the area that you want to detect

motion.

3. Repeat these steps for each channel that you want to use Smart Search.

#LX400022; r.16694/30364; en-US 28



Search (Playback)12

4. Click to start the Smart Search playback. To stop the Smart Search playback,

click again.
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Backup video files to external USB flash drive (not included) or self-powered USB exter-
nal hard drive (not included).

NOTE

USB external hard drives must be formatted in the FAT32 file format to be used with the system.

13.1 Formatting the USB Thumb Drive

It is recommended to format your USB thumb drive (not included) before using it with the
system.

CAUTION

Formatting the USB device will permanently erase all data.

To format a USB device:

1. Insert a USB thumb drive (not included) into one of the USB ports.
2. From live view, right-click and then selectMain Menu. Login if prompted.

3. Click >Backup.

4. Select the USB device you would like to format under Device Name and click
Browse.

5. Click Format. Click OK to confirm.

13.2 Backing up Video

1. Insert a USB thumb drive (not included) into one of the USB ports.
2. From live view, right-click and then selectMain Menu. Login if prompted.
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3. Click >Backup.

4. Configure your search options:

• Select the USB device you would like to format under Device Name.
• Type: Select the recording type you would like to search for or select All to search
all recording types.

• Channel: Select the channel you would like to search or select All to search all
channels.

• File Format: Select DAV to save files to save files to .dav format. You can play-
back .dav files using the FLIR video player software from www.flirsecurity.com/pro.
Or, select ASF for .asf format. You can playback .asf files in VLC Media Player
(free download from www.videolan.org) on PC or Mac.

NOTE

VLC Media Player is a free software available from www.videolan.org. VLC Media Player is not
supported by FLIR.

• Start Time/End Time: Select the start and end time for your search.

5. Click Add. A list of files that match your search criteria appears.
6. Check files you would like to backup and then click Backup. Wait for the backup to

complete.

NOTE

HD video files saved on the system may take up a large amount of disk space. The size of video
files selected and the amount of free space on your USB device is shown at the top of the screen.

13.3 Using Video Clip Backup

Video clip backup allows you to select a duration of video during playback mode and
save it to a USB device (not included).

To use Video Clip Backup:

1. Insert a USB thumb drive (not included) or USB external hard drive (not included) into
one of the USB ports.

2. Start playing back video using the steps in 12.1 Playing Back Video from the Hard
Drive, page 26.

3. Click to mark the beginning of the video clip. Click again to mark the end
of the video clip.

4. Click to open the Backup menu.
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5. Configure the following:

5.1. Check the USB device where you would like to save the file.
5.2. Check the files you would like to backup.
5.3. Click Backup. Then click Start. Wait for the backup to complete before re-

moving the USB thumb drive.

13.4 Viewing Backup Files

To playback .dav backup video files, aFLIR Cloud™ Player is available for PC and Mac
at www.flirsecurity.com/pro.

13.4.1 Viewing Backup Files on PC

You can download Video Player for PC from www.flirsecurity.com/pro.

To view backup video files using the Player on PC:

1. Download and install the Video Player for PC from www.flirsecurity.com/pro.

2. Click to open a back up video file.

3. Use the Player controls to control playback or select other files for playback.
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Video Player Controls

1. File List: Double-click to open a file.

2. Display Area: Select the split-screen mode. Double-click a video file to expand.
Click the controls inside the display area to do the following:

• : View information about the video file.

• : Start/stop a manual recording from the video file.

• : Take a snapshot from the video file.

• : Close the video file.

3. Hide/show file list.

4. Playback controls:

• : Playback files in sequence.

• : Synchronize playback times.

• : Play/pause playback.

• : Stop playback.

• : Previous frame.

• : Next frame.

• : Playback speed.

• : Volume control.

5. Zoom Timeline.
6. Add Files: Click to open back up video files.
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7. Digital Zoom: Click to activate digital zoom mode. Click and drag in the video to
zoom in. Right-click to unzoom.

8. Drag: When digital zoom is activated, click to activate drag mode. Then click and
drag in the video to view different areas of the image.

9. Full-screen: Click to open the player in full screen. Press ESC to exit full screen.
10.Config: Click to open the configuration menu for the player. From here you can con-

trol the default file formats and save locations for snapshots and video files saved
from the player.

13.4.2 Viewing Backup Files on Mac

AVideo Player for Mac is available from www.flirsecurity.com/pro.

To view backup video files using the Player on Mac:

1. Download Video Player for Mac from www.flirsecurity.com/pro.
2. Double click the downloaded file in Safari to extract the Smart Player app file.

3. Drag the Smart Player app to your Desktop or Applications list. Double click Smart

Player ( ) to open it.
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4. Click to open a back up video file in another location.

5. Use the Player controls to control playback or select other files for playback.

Video Player Controls

1. File List: Double-click to open a file.

2. Display Area: Select the split-screen mode. Double-click a video file to expand.
Click the controls inside the display area to do the following:

• : View information about the video file.

• : Take a snapshot from the video file.

• : Close the video file.

3. Hide/show file list.
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4. Playback controls:

• : When a video file ends, this button lets you select if you want the video player
to repeat the same file or play the next file.

• : Play/pause playback.

• : Stop playback.

• : Previous file.

• : Next file.

• : Playback speed.

• : Volume control.

5. Zoom Timeline.
6. Add Files: Click to open back up video files.
7. Full-screen: Click to open the player in full screen. Press ESC to exit full screen.
8. Config: Click to open the configuration menu for the player. From here you can con-

trol the default file formats and save locations for snapshots and control the aspect
ratio.

9. About: Click to see version information for the Player software.
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14

By default, the system user name is admin and the password is 000000. Passwords are
enabled by default and are required to access the Main Menu or connect to the system
using a computer or mobile device. You will be prompted to create a custom password
after you connect for the first time.

NOTE

If you forget the password to the system, contact technical support to have it reset.

The system includes the following default accounts:

• admin: The admin account has full access to the system, may configure all system
settings, and can manage user accounts.

• default: The default account is a limited user account that may only view live video
from the cameras.

For security reasons, it is essential that you change the password on your system. By
default, the system password is enabled.

14.1 Changing Passwords

You can change the system password of the admin and user accounts from the Users
menu.

To modify an account password:

1. From Live View, right-click and then selectMain Menu.
2. If prompted, enter the system user name (default: admin) and password (default:

000000).

3. Click and select Setting. Select Account.

4. Click next to the user account you would like to modify.

5. CheckModify Password.
6. Under Old Password, enter the account’s previous password.
7. Under New Password, enter a new 6 character password for the account. Repeat

the new password under Confirm Password.
8. Click OK to save changes.

14.2 Adding Users

You can allow multiple users to log in to the system. When adding different users, you
can assign what menus they have access to. For example, you may want your friend to
monitor your system while you are away, while not giving full access to your system.

To add a user account:

1. From Live View, right-click and then selectMain Menu.
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2. If prompted, enter the system user name (default: admin) and password (default:
000000).

3. Click and select Setting. Select Account.

4. Click Add User.
5. Configure the following:

• Username: Enter a name for the user account.
• Password: Enter a 6 character password for the user account. Enter the pass-
word again under Confirm Password.

• Memo (optional): Enter a description of the user account.
• Group: Select the group you would like to assign to this user account. A user ac-
count cannot be given permissions its group does not have.

• Multiuser: Check to enable this user account to be used to login from more than
one device at the same time.

• Authority: Check the permissions you would like the user account to have. Under
the System tab, select the menus the user account may access. Under the Play-
back tab, select which channels the user account may access recorded video
from. Under the Covert tab, select the channels the user account may view live
video from.

6. Click OK to save changes.

Now, you can log in to the system locally, or remotely using the user name and password
you created. When logging into the system with a user account, the user will only have
access to the menus you assigned.

14.3 Modifying Users

1. In the Account menu, click next to the user account you would like to modify.

2. Update the user’s account details as needed, and then click OK to save changes.

14.4 Deleting Users

1. In the Account menu, click next to the user account you would like to delete.

2. Click OK to confirm.

NOTE

The admin and default user accounts cannot be deleted from the system.

14.5 Account Groups

Account groups can be used to easily manage permissions for multiple user accounts.
User accounts can be given all the permissions of a group, but cannot be given permis-
sions that the group does not have.
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The system includes the following groups by default:

• admin: Accounts in the admin group are system administrators. They have full access
to the system, may configure all system settings, and can manage user accounts.

• user: Accounts in the user group are normal users. They have limited access to sys-
tem menus.

14.6 Adding Groups

1. From Live View, right-click and then selectMain Menu.
2. If prompted, enter the system user name (default: admin) and password (default:

000000).

3. Click and select Setting.

4. Click Account and select the Group tab.
5. Click Add Group.

6. Configure the following:

• Under Group Name, enter a name for the group.
• UnderMemo, enter an optional comment for this group.
• Under Authority, check the permissions that the group will have. User accounts
assigned to this group can not be given any permissions the group does not have.

7. Click OK to save changes.

14.7 Modifying Groups

1. In the Group tab, click next to the group you would like to modify.

2. Update the group’s details as needed, and then click OK to save changes.

14.8 Deleting Groups

1. In the Account menu, click next to the user account you would like to delete.
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2. Click OK to confirm.

NOTE

The admin and user groups cannot be deleted from the system.
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To open the Main Menu:

• Using the mouse: Right-click and clickMain Menu.

NOTE

The system password is required to access the Main Menu. By default the user name is admin and
the password is 000000.

1. SEARCH: Open Search/Playback mode. For details, see 12 Search (Playback),
page 26.

2. BACKUP: Export files to USB device. For details, see 13 Backup, page 30.
3. CAMERA: Open the menu to manage IP cameras connected to the network (see

6.11 Connecting Cameras to the Local Area Network (LAN) for details), set recording
parameters, and assign custom titles for your cameras.

4. INFO: View system information.
5. SETTING: Configure general system, schedule, network, recording, display, and mo-

tion settings. Restore system to factory defaults.
6. SHUTDOWN: Logout, restart, or shutdown the system.

15.1 Camera

Open the Remote Device menu to manage IP cameras, set recording parameters, and
assign custom titles for your cameras.

15.1.1 Remote Device

The Remote Device menus allow you to add cameras over the local area network (LAN),
configure camera image settings, view camera status, and upgrade camera firmware.

• See 6.11 Connecting Cameras to the Local Area Network (LAN), page 11 for instruc-
tions on connecting cameras to the NVR over the network.

• See 9.3 Adjusting Camera Image Settings, page 18 for details on setting up camera
image settings.

15.1.2 Viewing Camera Status

The Camera Status menu allows you to view the connection and alarm status for all con-
nected cameras.
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To view camera status:

1. From the Main Menu, click and select Remote Device>Status.

15.1.3 Viewing Camera Firmware Versions

You can use the Firmware menu to view firmware versions for connected cameras.

To view camera firmware versions:

1. From the Main Menu, click and select Remote Device>Firmware.

15.1.4 Upgrading Camera Firmware

You can update the firmware for select FLIR IP camera models through the NVR. Firm-
ware upgrades provide enhanced functionality for the cameras.

NOTE

Firmware upgrade via NVR is supported only on select FLIR IP cameras. A list of cameras compatible
with firmware upgrade via NVR is available at www.flirsecurity.com/pro.

To upgrade the camera firmware:

1. Download the camera firmware from www.flirsecurity.com/pro if one is available.

NOTE

Make sure that the firmware file you are using is compatible with your IP camera model.

2. Extract the firmware file and copy it to a USB thumb drive (not included).
3. Insert the USB thumb drive (not included) into a USB port on the system.
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4. Right-click and selectMain Menu. Click and select Remote
Device>Upgrade.

5. Click Select. Select the firmware file on the USB drive and click OK.
6. Check the cameras you would like to apply the upgrade to in the list and then click

Start Upgrade.

CAUTION

Wait for the firmware upgrade to complete before turning off or unplugging the cameras or NVR.
The cameras will restart during the firmware update process.

15.1.5 Recording

The Recording menu allows you to set recording parameters for your cameras, such as
the resolution and frame rate.

15.1.6 Configuring Recording Quality

The system employs two video recording streams, a Main Stream and a Sub Stream.
The Main Stream records high quality video to your system’s hard drive. The Sub Stream
records lower resolution video for efficient streaming to devices over the Internet. You
can customize the video quality settings for these streams according to your needs.

To configure recording quality:

1. From the Main Menu, click and select Recording>Recording.

2. Under Channel, select the camera you would like to configure.
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3. Configure the following settings. Settings for the Main Stream are in the left column.
Settings for the Sub Stream are in the right column.

• Resolution: Select the resolution that you want to use to record the selected
channel. Higher resolutions create a more detailed image, but take up more hard
drive space to record and require more bandwidth to stream to connected com-
puters or mobile devices.

NOTE

Available resolutions for the Main Stream and Sub Stream depend on the model of camera that
is connected to the system.

• Compression: Select the video compression type that will be used. It is recom-
mended to select H.264, as it will have the best performance and use the least
amount of disk space.

• Frame Rate (FPS): Select the frame rate in Frames Per Second (FPS) that each
stream will record at. A higher frame rate provides a smoother picture, but requires
more storage and bandwidth.

• Bit Rate Type: Select CBR (Constant Bit Rate) or VBR (Variable Bit Rate) to de-
termine the bit rate type. If you select VBR, you can set the video quality setting
between 1 and 6. If you select VBR, select the Quality from 1 (lowest) to 6
(highest).

• Bit Rate (Kbps): Select the bit rate for each recording stream. A higher bit rate re-
sults in a better image, but increases the amount of hard drive space or bandwidth
required.

4. (Optional) Click the Copy button to copy recording settings to other channels.
5. Click OK to save changes.

15.1.7 Configuring Audio Recording

The system supports audio recording.

NOTE

Audio-enabled cameras (not included) are required to use audio recording. The MIC IN port is reserved
for two-way audio.
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To configure audio recording:

1. From the Main Menu, click and select Recording>Recording.

2. Select the audio-enabled camera under Channel.
3. Check the left Audio/Video checkbox to enable audio recording. Check the middle

checkbox to enable audio streaming to remote devices (such as a smartphone).
Check the right checkbox to enable video streaming to remote devices.

4. Click OK to save changes.

15.1.8 Configuring Snapshot Recording Settings

The system can be set to record snapshot images when a camera detects motion. These
snapshots can be viewed through the Search menu or can be attached to email alerts
and push notifications. The Snapshot tab in the Recording menu controls the quality and
recording parameters for each camera.

NOTE

In order to enable Snapshot recording, the following menu options must be configured:

• The Snapshot schedule must be enabled for times that you would like to save snapshots. See
15.3.17 Configuring the Snapshot Schedule, page 61.

• Snapshot recording must be enabled for motion detection in the Event menu. See 15.3.8 Configur-
ing Motion Detection, page 55.

To configure snapshot recording settings:

1. From the Main Menu, click and select Recording>Snapshot.

2. Under Snap Number, select the number of snapshots the system will take when the
snapshot button is pressed.
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3. Configure the following settings for snapshots saved automatically from motion de-
tection or the snapshot schedule:

• Channel: Select the channel you would like to configure.
• Mode: Select Timing for the system to take snapshots according to the snapshot
schedule (see 15.3.17 Configuring the Snapshot Schedule, page 61) Select Trig-
ger for the system to take snapshots only when triggered by motion detection
(snapshot must be enabled in the Motion Detect menu; see 15.3.8 Configuring
Motion Detection, page 55).

• Image Size: The image size is the same as the Main Stream resolution of the
camera.

• Image Quality: Select the snapshot image quality between 1 (lowest) and 6
(highest).

• Snapshot Frequency: Select the number of snapshots (up to 6) the system will
take each time.

4. Click OK to save changes.

15.1.9 Creating Custom Channel Names

You can assign custom names to your cameras. For example, you can name your cam-
eras based on their location (e.g. hallway or front door).

To create custom channel names:

1. From the Main Menu, click and select Channel Name.

2. Enter a custom name for each channel.

3. Click OK to save changes.
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15.2 Info

Info contains menus that show you system information.

15.2.1 HDD Info

The HDD Info sub-menu shows information related to the hard drives installed in the sys-
tem, including capacity, status, and type.

To access the HDD Info menu:

• From the Main Menu, click and then click Info>HDD Info.

15.2.2 Record Info

The Record Info menu shows the start and end times of recordings saved on the hard
drive.
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To access the Record Info menu:

• From the Main Menu, click and then select Info>Record Info.

15.2.3 Version

The Version sub-menu allows you to view information about the current firmware installed
on the system.

To access the Version menu:

• From the Main Menu, click and then click Info>Version.

15.2.4 Event Info

The Event Info menu shows you a display of system alarms. Activated alarms are high-
lighted in white. Additional info such as channels that are currently detecting motion is
shown.

The following alarms are shown in the Alarm Status menu:

• No HDD: No hard drive is detected.
• Disk Error: Hard drive error detected.
• Disk Full: Hard drive is full.
• IP Conflict: More than one device on the network is using the same IP address.
• Net Offline: System is not connected to the network.
• MAC Conflict: More than one device on the network is using the same MAC address.
• External Alarm: Sensor/alarm device (not included) has been triggered.
• Video Loss: Shows disconnected channels.
• Camera Masking: Camera masking alarm has been triggered (e.g. someone has
covered the camera lens).

• Motion Detect: Shows channels with active motion alarms.
• IPC Ext Alarm: Alarm/sensor device (not included) connected to camera has been
triggered.

• IPC Offline Alarm: IP camera is offline.

#LX400022; r.16694/30364; en-US 48



Using the Main Menu15

To access the Event Info menu:

• From the Main Menu, click and then select Event.

15.2.5 Online Users

The Online Users menu shows a list of users connected to the system using computers
or mobile devices.

To access Online Users:

• From the Main Menu, click and then select Network.

15.2.6 Load

The Load menu shows you the network traffic your system is sending and receiving.

To access Load:

• From the Main Menu, click and then select Network>Load.

15.2.7 Test
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The Test menu allows you to test if your system can connect to other devices over the
LAN or Internet. You can enter the IP address of a device and click Test to determine if
your system can connect to it.

To access Test:

• From the Main Menu, click and then select Network>Test.

15.2.8 BPS

The BPS sub-menu shows the bitrates of connected cameras. the bitrate is the amount
of data the camera is sending to the system.

To access BPS:

• From the Main Menu, click and then select BPS.

15.2.9 Log

The Log sub-menu allows you to search for system logs.

To search for system logs:

1. From the Main Menu, click and then select Log.

2. Under Type, select the log type to search for.
3. Under Start Time and End Time, select the start and end time for your search.
4. Click Search.
5. (Optional) Click Backup to export logs to a USB thumb drive connected to the

system.
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15.3 Setting

The Setting menu allows you to configure general system, schedule, network, recording,
display, and motion settings. It also allows you to restore the system to factory defaults.

15.3.1 Network

The Network menu allows you to configure network parameters for your system.

NOTE

The WiFi menu is not supported.

15.3.2 Selecting DHCP or Static IPAddress (TCP/IP)

The TCP/IP menu allows you to configure IP address settings.

To configure IP address settings:

1. From the Main Menu, click and then select Network>TCP/IP.

2. Check DHCP (recommended) to let the system automatically obtain an IP address
from the router or uncheck to assign a static IP address.

If you uncheck DHCP, configure the following:

• IPAddress: Enter the IP address you would like to assign to the system. Make
sure that no other device on your network is using the same IP address.

• Subnet Mask: Enter the subnet mask for your network.
• Default Gateway: Enter the gateway address for your network.
• Preferred DNS: Enter the address of your primary DNS server.
• Alternate DNS: Enter the address of your secondary DNS server.

3. Click OK to save changes.
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15.3.3 Configuring System Ports (Connection)

The Connection menu allows you to configure ports used by the system. Please note that
port forwarding is not required to use FLIR Cloud™ or to connect using the apps.

If you are using DDNS connectivity, port forwarding is required for the HTTP Port (defaut:
80) and TCP (Client Port) (default: 35000).

To configure system ports:

1. From the Main Menu, click and then select Network>Connection.

2. Configure the ports as needed and click OK to save changes.

NOTE

Up to 3 devices may connect to the system at the same time when using FLIR Cloud™.

15.3.4 Configuring DDNS Settings

FLIR DDNS is available as an optional connectivity option. Please see 20 DDNS Setup
(Advanced), page 139 for details.

The primary connectivity option uses FLIR Cloud™ to connect to your system over the
Internet without requiring port forwarding or DDNS registration. For details, see 16 Con-
necting to Your System Over the Internet on PC or Mac, page 72.

To configure DDNS Settings:

1. Visit http://ddns.myddns-flir.com and register for a DDNS account.

2. From the Main Menu, click and then select Network>DDNS.

3. Check Enable.
4. Under Domain Name, enter the Domain Name/URL Request your received in the

email after registering for DDNS.
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5. Under User ID, enter your DDNS User Name.
6. Under Password, enter your DDNS Device password.
7. Click OK to save your settings.

NOTE

Please allow 10~15 minutes for the DDNS servers to update with your new DDNS address before
attempting to connect.

15.3.5 Configuring Email Alerts

You can configure the system to send out email alerts for motion detection or other
events.

NOTE

To send out motion detection alerts, you must enable the Send Email option for motion detection on
each camera you would to receive alerts from. For details, see 15.3.8 Configuring Motion Detection,
page 55.

NOTE

SMTP server connection information is required to set up email alerts. Contact your email service pro-
vider to retrieve your SMTP server information.

To configure Email Alerts:

1. From the Main Menu, click and then select Network>Email.

2. Check Enable to enable email notifications.
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3. Configure the following:

• SMTP Server: Enter the SMTP server address.
• Port: Enter the port used by the SMTP server.
• Anonymous: Check if your server supports anonymous log ins. Otherwise, leave
this unchecked.

• User Name: Enter the SMTP user name.
• Password: Enter the SMTP password.
• Receiver: Enter the email address that will receive alerts.
• Sender: Enter the sender’s email address.
• Subject: Enter the subject line for the email alert.
• Attachment: Check to include a jpg image attachment of the camera.

NOTE

You must enable the Snapshot option for motion detection on each camera you would to receive
attachments. For details, see 15.3.8 Configuring Motion Detection, page 55.

• Encrypt Type: Select SSL or TLS if your server uses encryption. Select None if
your server does not use encryption.

• Event Interval: Enter the interval between alert emails.
• Health Enable: Check to enable health check emails. Health check emails will be
sent periodically to ensure that the system is functioning normally.

• Interval: Enter the interval in minutes for health check emails.

4. Click Test to send a test email.
5. Click OK to save settings.

15.3.6 Configuring Switch Settings (Advanced)

You can configure the networking settings for the internal PoE switch.

CAUTION

It is recommended to leave this menu on the default settings. Changing the information in this menu
may disrupt the connection to the cameras.

To configure switch settings:

1. From live view, right-click and selectMain Menu.

2. Click >Network>Switch Settings.

3. Configure the IPAddress, Subnet Mask, and Gateway for the internal PoE switch.

4. Click OK. Click Save to save changes. The system will restart.

15.3.7 Event

The Event menu allows you to configure settings for motion detection, video loss, and
system warnings.
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15.3.8 Configuring Motion Detection

Motion Detection events allow the system to mark footage that has motion. This allows
you to quickly locate relevant footage through Search. You can also configure system re-
sponses to motion detection events, such as activating the system buzzer or sending an
email alert.

To configure Motion Detection events:

1. From the Main Menu, click and then click Event>Motion>Motion Detect.

2. Under Channel, select the channel you would like to configure.
3. Check Enable to enable motion detection on the selected channel.
4. Click Setup next to Region to configure which areas of the image will be enabled for

motion detection. A grid will appear over the camera’s live view.

Motion Grid

• Areas enabled for motion detection are shown in color and areas that are disabled
are transparent.

• Hover the mouse at the top of the screen to select which motion area you would
like to configure. You can set up to 4 motion detection areas and customize the
sensitivity and threshold for motion detection separately for each area between 0
(lowest) and 100 (highest).

• The Sensitivity determines how sensitive the camera is to motion. For example, if
the sensitivity is high, small amounts of motion are more likely to trigger an event.
It is recommended to select a Sensitivity between 30~70.

• The Threshold determines how much motion is required to trigger an event. If the
amount of motion exceeds the threshold, an event occurs. It is recommended to
select a Threshold between 10~50.

• Right-click when finished.

NOTE

It is recommended to have a second person walk in front of the camera to test different Sensitivity
and Threshold settings to determine the best setting for your camera’s location.
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5. Under Anti-dither, enter the anti-dither time. After a motion event occurs and motion
stops, if motion is detected within the anti-dither time, the system continues the mo-
tion event and includes the new motion within the first event, rather than creating a
new motion event.

6. Under Post_REC, enter the time the system will record after a motion event occurs.
7. To configure a schedule when motion detection will be enabled on this channel, click

Setup next to Period. Configure times when motion detection will be enabled. For ex-
ample, you may want to disable motion detection during business hours and enable it
outside of business hours. Click OKwhen finished.

NOTE

This setting can override scheduled motion recording. This means that motion recording will only
take place at times that are enabled both in the Schedule menu and here.

8. Configure the following system actions when motion is detected:

• Alarm Out: Check the box to activate alarm output devices (not included) that will
trigger when the selected channel detects motion. Select the alarm output devices
that will be activated when motion is detected.

• Latch: Enter the number of seconds an alarm output device will activate after mo-
tion is detected.

• Show Message: Check to enable an on-screen pop-up when one of your cam-
eras detects motion. On-screen pop-up shows the channels an event occurred on
and the type of event.

• Alarm Upload: Check to enable the system to upload alerts to FLIR Cloud™
Client.

• Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 15.3.5 Configuring Email Alerts, page 53).

• Channels: Select the channels that will record when motion is detected on the se-
lected channel.

• PTZ Activation: Check to enable PTZ actions when motion is detected (PTZ
camera required; not included). Click Setup to select which PTZ actions will be
taken by each camera.

• Buzzer: Check to enable the system buzzer.
• Sequence: Check to enable a custom sequence mode when motion is detected
on the selected channel. Then click the channels you would like to display in the
custom sequence mode.

• Snapshot: Check to save a snapshot when the camera detects motion.

9. Click OK to save changes.

15.3.9 Configuring Video Loss Settings

Video Loss occurs if the system loses connection to one of the cameras.

To configure Video Loss settings:

1. From the Main Menu, click and then click Event>Motion>Video Loss.
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2. Under Channel, select the channel you would like to configure.
3. Check Enable to enable video loss events for the selected channel.
4. Configure the following to customize settings for video loss events:

• Period: Click Setup to configure a schedule for video loss events. It is recom-
mended to leave this on the default setting, so you can be alerted at any time one
of your cameras loses video.

• Alarm Out: Select the alarm output devices (not included) that will trigger when
video loss occurs.

• Latch: Enter the number of seconds an alarm output device will activate after vid-
eo loss occurs.

• Show Message: Check to show a popup message on the monitor if one of your
cameras loses video.

• Alarm Upload: Check to enable the system to upload alerts to FLIR Cloud™
Client.

• Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 15.3.5 Configuring Email Alerts, page 53).

• Channels: Click the checkbox to enable video recording when video loss occurs.
You can then select the channels the system will record when video loss occurs
on the currently selected channel.

• PTZ Activation: Check to enable PTZ actions when video loss occurs (PTZ cam-
era required; not included). Click Setup to select which PTZ actions will be taken
by each camera.

• Post_REC: Enter the number of seconds the system will record after video loss
occurs.

• Snapshot: Click the box to enable snapshot recording when video loss occurs.
You can then select which channels will save snapshots when video loss occurs
on the currently selected channel.

• Sequence: Check to enable a custom sequence mode when video loss occurs
on the selected channel. Then click the channels you would like to display in the
custom sequence mode.

• Buzzer: Check to enable the system buzzer when video loss occurs on the cur-
rently selected channel.

5. Click OK to save changes.

15.3.10 Configuring Alarm Input Devices

You can connect alarm input devices such as motion sensors (not included) or glass
break detectors (not included) to the system. The system can be set to trigger recording
or take other actions when these devices are activated.

To configure alarm input devices (not included):

1. From the Main Menu, click and then click Event>Alarm.
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2. Configure the following to activate an alarm input device:

• Alarm In: Select the alarm input port the device is connected to.
• Enable: Check to enable the alarm input device connected to the selected port.
• Type: Select Normal Open or Normal Close depending on the type of alarm in-
put device you have.

3. Configure the following system responses and parameters for the alarm input device:

• Period: Click Setup to configure the times of the week when the selected device
will be activated. By default, the device will be activated 24/7.

• Anti-dither: Enter the anti-dither time. After the device triggers, if it triggers again
within the anti-dither time, the system continues the event and includes the second
activation within the first event, rather than creating a new event.

• Alarm Out: Check the box to activate alarm output devices (not included) and se-
lect the alarm output devices (not included) will be activated when the selected de-
vice is triggered.

• Latch: Enter the number of seconds an alarm output device will activate after the
selected device is triggered.

• Show Message: Check to enable an on-screen pop-up when the selected device
is triggered.

• Alarm Upload: Check to enable the system to upload alerts to FLIR Cloud™
Client.

• Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 15.3.5 Configuring Email Alerts, page 53).

• Channels: Select the channels that will record when the selected device is
triggered.

• PTZ Activation: Check to enable PTZ actions when the selected device is trig-
gered (PTZ camera required; not included). Click Setup to select which PTZ ac-
tions will be taken by each camera.

• Sequence: Check to enable a custom sequence mode when the alarm device
triggers. Then click the channels you would like to display in the custom sequence
mode.

• Buzzer: Check to enable the system buzzer.
• Snapshot: Check to save a snapshot.

4. Click OK to save changes.

15.3.11 Controlling Alarm Output Devices

You can connect alarm output devices (not included), such as sirens or strobe lights, to
the system. The Alarm Output menu allows you to enable or disable alarm output devices
and manually an activated device.

To access the Alarm Output menu:

1. From the Main Menu, click and then click Event>Alarm Output.
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To control alarm output devices:

• To enable alarm output devices, select Schedule orManual for each device you
would like to enable. Select Stop to disable the alarm output device. Click OK to save
changes.

• To manually disable activated alarm devices, click OK under Alarm Release.

15.3.12 Configuring Hard Drive Warnings

Hard drive warnings will notify you if an issue is detected with the hard drive.

To configure hard drive warnings:

1. From the Main Menu, click and then click Event>Warning>HDD.

2. Under Event Type, select the hard drive event you would like to configure.

• No Disk: No hard drive detected.
• Disk Error: A hard drive error has been detected.
• Disk Full: The hard drive is full or almost full. You can enter the percentage of disk
space remaining that will trigger a warning under Less Than (e.g. when less than
10% of the hard drive is empty, trigger a warning). Disk Full warnings will not occur
if overwrite is enabled.

• All: Configure warnings for all hard drive events.

3. Configure the responses the system will take when the selected event occurs:

• Alarm Out: Activate selected alarm out devices. Use Latch to select the number
of seconds the alarm out device will be activated.

• Show Message: Show a popup message on the monitor.
• Alarm Upload: Check to enable the system to upload alerts to FLIR Cloud™
Client.

• Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 15.3.5 Configuring Email Alerts, page 53).

• Buzzer: Check to activate the system buzzer.

4. Click OK to save changes.

15.3.13 Configuring Network Warnings

Network warnings will notify you if your system loses connection to the Internet or local
network or if there is an issue on your network.
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To configure network warnings:

1. From the Main Menu, click and then click Event>Warning>Network.

2. Under Event Type, select the event type you would like to configure.

• Net Disconnection: The system has lost connection to the network.
• IP Conflict: More than one device on your network has the same IP address.
• MAC Conflict: More than one device on your network has the same MAC address.
• All: Configure responses for all network events.

3. Configure the following for the selected event type:

• Alarm Out: Activate selected alarm out devices. Use Latch to select the number
of seconds the alarm out device will be activated.

• Enable: Check to enable the selected event type.
• Show Message: Check to show a popup message when the selected event
occurs.

• Send Email: Check to enable email alerts. You must configure email alerts before
you will be able to receive them (see 15.3.5 Configuring Email Alerts, page 53).

• Buzzer: Check to activate the system buzzer.

4. Click OK to save changes.

15.3.14 Storage

The Storage menu allows you to configure the recording schedule and hard drives con-
nected to the system.

15.3.15 Configuring the Video Recording Schedule

You can set a custom recording schedule according to your needs. For example, you can
set the system to record continuously during business hours and record on motion de-
tection only outside of business hours.

A custom recording schedule helps reduce the amount of hard drive space required, in-
creasing the time your system can retain recordings.

To configure the video recording schedule:

1. From the Main Menu, click and then click Storage>Schedule>Record.

2. Under Channel, select the channel you would like to configure or select All.
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3. Configure the schedule as needed:

• Check Continuous or MD (motion detection) to select the recording type you
would like to configure.

• Click and drag on each day to customize the recording schedule. The schedule is
set up as a grid, which each block representing one hour.

• Click next to All to link the recording schedules for all days. The icon for a

day changes to when days are linked. You can also click the boxes next to
individual days to link them to each other. If the recording schedule is linked,
changes made to one of the days will apply to every day that is linked.

• Click to disable all recording of the selected type on the selected day.

• Click if you need to set a more precise schedule down to the minute.

4. Click OK to save changes.

15.3.16 Configuring Pre-Recording

The system can pre-record video when motion detection events occur.

To configure pre-recording:

1. From the Main Menu, click and then click Storage>Schedule>Record.

2. Under Channel, select the camera you would like to configure or select All.
3. Under PreRecord, select the duration for pre-recording.
4. Click OK to save settings.

15.3.17 Configuring the Snapshot Schedule

You can set a schedule for recording snapshots from the cameras.

To set up the snapshot schedule:
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1. From the Main Menu, click and then click Storage>Schedule>Snapshot.

2. Under Channel, select the channel you would like to configure or select All.

3. Configure the schedule as needed:

• Check Continuous or MD (motion detection) to select the recording type you
would like to configure.

• Click and drag on each day to customize the recording schedule. The schedule is
set up as a grid, which each block representing one hour.

• Click next to All to link the recording schedules for all days. The icon for a

day changes to when it is linked. You can also click the boxes next to individ-
ual days to link them to each other. If the recording schedule is linked, changes
made to one of the days will apply to every day that is linked.

• Click to disable all recording of the selected type on the selected day.

• Click if you need to set a more precise schedule down to the minute.

4. Click OK to save changes.

15.3.18 Configuring Holidays

You can set certain days as holidays. Holidays have a special recording schedule.

To configure holidays:

1. From the Main Menu, click and then click Setting>General>Holiday.

2. Click Add New Holidays.
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3. Configure the following:

• Holiday Name: Enter a name for this holiday.
• Repeat Mode: Select Once Only for the holiday to occur only this year or All-
Year for the holiday to be repeated each year.

• Holiday Range: Select Date to select a specific date, or selectWeek to select
holidays based on which week they fall on.

4. Click Add. Now that you have added a holiday, an extra holiday setting is added to
the recording schedule.

NOTE

You cannot delete holidays, but you can disable them by selecting Stop under the Status drop-
down and then click Apply.

15.3.19 Formatting the Hard Drive

The HDD Manager menu allows you to format the hard drive. If you install a new hard
drive, you must format the hard drive using the system before you will be able to record.

To format the hard drive:

CAUTION

Formatting the hard drive erases all data on the hard drive. This step cannot be undone.

1. From the Main Menu, click and then click Storage>HDD Manager.

2. Select the hard dive you would like to format and then click Format. Click OK to
confirm.

3. Click OK to save changes. The system will restart to complete the formatting process.

15.3.20 Configuring Hard Drive Type

The system supports the following hard drive types:
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• Read-write HDD: Normal recording hard drive.
• Read-only HDD: The system can playback data from this hard drive, but it will not re-
cord to it.

• Mirror HDD: The hard drive will be used for mirror recording only. You must set up
mirroring recording before this feature will work.

To set the hard drive type:

1. From the Main Menu, click and then click Storage>HDD Manager.

2. Click the hard drive you would like to configure.
3. Under Type, select Read-write HDD, Read-only HDD, orMirror HDD.
4. Click OK to save changes. The system will restart to complete this operation.

15.3.21 Setting up Hard Drive Mirroring (Advanced)

A mirror hard drive can be used to automatically backup video footage recorded to the
recording (read-write) hard drive. When a mirroring hard drive is installed, the system
can be set to record cameras in parallel to both the recording hard drive and the mirror
hard drive. This way, the footage is automatically backed up if the recording hard drive
fails.

How hard drive mirroring works:

1. Security system.
2. Primary hard drive.
3. Mirror hard drive.

NOTE

• The mirror hard drive must be as large or larger than primary hard drive to backup all recordings.
• HDD mirroring begins from when mirror hard drive is installed and configured.
• Two hard drives must be installed in the system to use HDD mirroring. For details on installing hard

drives, see 22 DNR400 Series Hard Drive Installation, page 153.

To set up hard drive mirroring:

1. From the Main Menu, click and then click Storage>HDD Manager.
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2. Click the Type drop-down under the second hard drive and selectMirror HDD.

CAUTION

Setting a hard drive for mirroring erases all data on the hard drive. This step cannot be undone.

3. Click OK to apply changes. Click Yes to confirm. The system will format the hard
drive and restart.

4. When the system restarts, click and then click
Storage>Schedule>Record.

5. Under Channel, select the channel you would like to enable for mirror recording, then
checkMirroring. Repeat the process for any additional channels.

6. Click OK to save changes.

15.3.22 Configuring Hard Drive Groups (Advanced)

Hard drive groups allow you to balance recordings across multiple hard drives. For ex-
ample, you can record channels 1~4 to one hard drive and 4~8 to a second hard drive.
This can reduce the amount of wear on the hard drives and may extend the life of the
hard drives.

NOTE

• Two hard drives must be installed in the system to use hard drive groups, and both hard drives must
be formatted as Read-write hard drives. For details on installing hard drives, see 22 DNR400 Series
Hard Drive Installation, page 153.

To configure hard drive groups:

1. From the Main Menu, click and then click Storage>HDD Advance>HDD
Setting.
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2. Under HDD Group, assign a group to each hard drive. To set up two hard drive
groups, assign one hard drive to group 1 and the other to group 2.

3. Click OK. The system will restart to apply changes.
4. When the system restarts, you must decide which channels will record to each hard

drive group.

5. From the Main Menu, click and then click Storage>HDD Advance>Main
Stream. For each channel, select the hard drive group you would like to record the
main stream (high quality) video and then click Apply.

6. Click the Sub Stream tab. For each channel, select the hard drive group you would
like to record the sub stream (reduced quality) video and then click Apply.
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7. Click the Picture tab. For each channel, select the hard drive group you would like to
record snap shots and then click Apply.

15.3.23 Configuring General System Settings

You can use the General menu to configure miscellaneous system settings.

To configure general settings:

1. From the Main Menu, click and then click Setting>General>General.

2. Configure the following:

• Device Type: Shows the model number of your system.
• Device No.: Select the remote control address of the system. See 8.1 Setting the
Remote Control Address, page 15.

• Language: Set the system languages. Available options are English, French, and
Spanish.

• Video Standard: Select NTSC (North America) or PAL (Europe).
• HDD Full: Select Overwrite for the system to overwrite the oldest recordings
when the hard drive is full or select Stop Record for the system to stop recording
when the hard drive is full.

• Pack Duration: Select the length (in minutes) of video files stored on the system.
For example, if this is set to 30 minutes, the system will create a new video file for
each 30 minutes of continuous recording.

• Instant Playback: Select the amount of time (in minutes) the system will go back
when instant playback is activated in live view.

• Auto Logout: Select the idle time (in minutes) before the system will logout the
current user.

• IPC Time Sync: Select how often (in hours) the NVR will update the time on the
IP cameras.

• Navigation Bar: Check to enable the Navigation Bar that comes up when you left
click in live view.

• Startup Wizard: Check to enable a setup wizard when you start up the system.
• Mouse Speed: Use the slider to adjust the mouse speed.
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3. Click OK to save changes.

15.3.24 Setting the Monitor Resolution (Display)

The Display menu allows you to configure the systems monitor resolution and other dis-
play settings.

To set the monitor resolution:

1. From the Main Menu, click and then click Setting>Display>Display.

2. Under Resolution, select the correct resolution for your monitor: 1920x1080,
1280x1024, 1280x720, or 1024x768.

3. Click OK to save changes. Click OK again to restart the system using the new
resolution.

To configure other display settings:

1. From the Main Menu, click and then click Setting>Display>Display.

2. Configure the following:

• Transparency: Select the menu transparency.
• Time Display: Check to show the time on the monitor.
• Channel Display: Check to show the channel names on the monitor.
• Image Enhance: Check for the system to digitally improve the video quality on
the live display. This setting does not affect recordings.

• Original Scale: Check to set the system to show the true aspect ratio of the cam-
eras on the live display. This may add black bars to the top and bottom of the
image.

3. Click OK to save changes.
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15.3.25 Saving Your System Configuration to a USB Thumb Drive

The system allows you to save your current system configuration to a USB thumb drive
(not included). This is useful if you want to backup your current settings.

NOTE

This function only saves settings created in system menus. It does not save or backup any video.

To save your system configuration to a USB thumb drive:

1. Insert a USB thumb drive (not included) into one of the USB ports.

2. From the Main Menu, click and then click Setting>Config Backup.

3. Under Device Name, select the USB device where you would like to save the
configuration.

4. Click EXPORT to save your current system configuration.

To restore a saved system configuration:

1. Insert a USB thumb drive (not included) with a saved system configuration into one of
the USB ports.

2. From the Main Menu, click and then click Setting>Config Backup.

3. Under Device Name, select the USB device.
4. Click the folder with the configuration files you would like to restore. Configuration file

folders are labeled “Config” and then the time and date the configuration was saved
(e.g. Config_20140425103727).

5. Click IMPORT to restore the system configuration.
6. Click OK to confirm. The system will restart to complete the operation.

15.3.26 Setting the System to Factory Defaults

The Default menu allows you to reset the system to factory default settings.
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To reset the system to factory default settings:

1. From the Main Menu, click and then click Setting>Default.

2. Check the menus you would like to reset to default settings.
3. Click OK.

15.3.27 Upgrading Firmware from USB

Firmware upgrades provide enhanced functionality. The system will automatically check
for firmware upgrades if it is connected to the Internet. The system also supports firm-
ware upgrades from a USB thumb drive (not included).

To upgrade firmware from a USB drive:

1. Download the firmware upgrade from www.flirsecurity.com/pro.
2. Extract the firmware file and copy the firmware to a blank USB thumb drive.

NOTE

Do not have any folders on the USB thumb drive—just the firmware file.

3. Insert the USB thumb drive to a USB port on the system.

4. Right-click and then clickMain Menu. Click >Setting>Upgrade.

5. Click Start.
6. Select the firmware file on the USB drive and click Start.

WARNING

DO NOT POWER OFF THE SYSTEM OR DISCONNECT THE POWER CABLE DURING FIRM-
WARE INSTALLATION
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15.4 Shutdown

Use the Shutdown menu to shutdown, restart, or log out of the system.

To access the Shutdown menu:

1. From live view, right-click and selectMain Menu.
2. Enter the system User Name (default: admin) and Password (default: 000000) and

click OK.

3. Click >Shutdown.

4. Select one of the following:

• Logout: Log out the account that is currently active.
• Shutdown.
• Restart.
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16

This system features connectivity using the exclusive FLIR Cloud™. This cloud-enabled
service allows for Internet connectivity without requiring any network configuration. Up to
3 devices may connect to the system at the same time.

NOTE

• Except where noted, the PC and Mac instructions in this section are the same.
• For smartphone/tablet setup, see 18 Connecting to your System Using Smartphone or Tablet Apps,

page 100.
• For the latest list of supported apps and devices, visit www.flirsecurity.com/pro.

16.1 System Requirements

Your system must meet the system requirements below:

Description Requirement

CPU Core 2 Duo 3.0GHz

Operating System Windows™ 8/7/Vista

Mac OSX 10.7 and above

Memory 2GB

Video 512 MB of video memory and above

Network (LAN) 10/100 BaseT Network

Network (WAN) 1 Mbps upstream
High-speed Internet service is required to re-
motely connect to your system.

16.2 Step 1 of 3: Connect your System to Your Router

1. Power off your system by disconnecting the power adapter.
2. Connect an Ethernet cable (included) to the LAN port on the rear panel of the system.

Connect the other end of the Ethernet cable to an empty LAN port (usually numbered
1~4) on your router.
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3. Reconnect the power adapter to power the system back on.

16.3 Step 2 of 3: Obtain the system’s Device ID

The Device ID is a unique code that allows your system to handshake with FLIR Cloud™
servers for a secure connection over the Internet.

To find the Device ID:

1. The Device ID is located on a sticker on the system.

2. Write down the Device ID of the system.

16.4 Step 3 of 3: Connect to the System Over the Internet

Follow the steps below to connect to the system over the Internet.

NOTE

Make sure to upgrade your system to the latest firmware version. You must have the latest firm-
ware and client software to connect to the system over the Internet.

To connect to the system over the Internet:

1. Download and install the client software.

• PC Users: Download and install the Client Software for PC from www.flirsecurity.
com/pro.

• Mac Users: Download and install the Client Software for Mac from
www.flirsecurity.com/pro. Double click to extract the software. Then, drag the soft-
ware to Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon ( ) from the
desktop or Applications list.
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3. Log into the Client Software using the Client Software user name (default: admin)
and password (default: admin) and then click Login.

4. Click Add Device.

5. Enter the following:

5.1. Device Name: Choose a name for your system of your choice.
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5.2. Device ID: Manually enter the Device ID printed on the label.
5.3. Client Port: Enter the Client Port (default: 35000).
5.4. User Name: Enter the system User Name (default: admin).
5.5. Password: Enter the system Password (default: 000000).

6. Click Add. If this is the first time you are connecting, you will be prompted to change
the system password.

7. Enter a new 6 character password and click OK. This password will be used to con-
nect to your system from now on.

8. Click then .
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9. Click and drag Default Group to the display window to open your cameras in live
view.

Congratulations! You can now connect over the Internet to view and playback video
on your computer.
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17

FLIR Cloud™ Client allows you to connect to multiple systems from a PC or Mac.

17.1 Home Page

The Home Page allows you to access all the tabs within the software. Each tab allows
you to access different features.

To open tabs:

Click a tab from the Home Page to open it or click the button at the top of the
screen from within any tab to open a new tab.

17.2 Live View

The Live View tab is where you can view live video from connected systems.

To view live video from a system:

1. Click and then click to create a Live View tab.

2. Click and drag a DVR, NVR, group, or individual camera to open live video. To ac-
cess individual cameras, you can click + to expand groups or systems.
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17.2.1 Live View Controls

1. Live display: Double-click to expand the area. Right-click to access additional op-
tions. Hold the mouse over the display area to access the camera toolbar.
Camera toolbar:

1.1. Streaming quality: Shows the bitrate and resolution for the stream, and
shows if display is showing the Sub Stream or Main Stream.

1.2. Manual recording: Click to start/stop manual recording.
1.3. Snapshot: Click to save a snapshot.
1.4. Mute/unmute: Click to mute/unmute audio (audio camera required).
1.5. Not supported.
1.6. Instant playback: Plays back the most recently recorded video from the

camera. By default, it will play back the last 5 minutes of recorded video from
the camera.

1.7. Digital zoom: Click to enable digital zoom mode. Click and drag over the dis-
play area to zoom on the camera. Then click and drag to pan. Click the icon
again to zoom out.

1.8. Disconnect.

1. Split-screen mode: Click to select split-screen layout.

2. Aspect ratio: Use the drop down menu to select the aspect ratio for the selected
camera. Original uses the actual aspect ratio of the image. Full-win stretches the
image to fill up the entire display area.

3. Full-screen: Click to open full-screen mode. Press ESC to exit full-screen mode.

4. Save view: Click to save the current display layout and open cameras as a view.
Then enter a name for the view.
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5. Start/stop tour: Click to start the tour. During the tour the client will cycle
through all saved views every few seconds. Click again to stop the tour.

6. PTZ Controls: Controls for PTZ cameras (not included). See 17.3 Controlling PTZ
Cameras, page 80 for details.

7. View: Click View to access view menu. Then double-click on a view to open it in the
display area.

8. Devices: Shows a list of groups, cameras, and systems connected to the client. Drag
items to the display area to open live video. Right-click to view additional options.

17.2.2 Opening Live View in Multiple Monitors

If your computer has multiple monitors, you can open more than one Live View tab and
move them to secondary monitors. This allows you to monitor cameras on multiple moni-
tors at the same time.

NOTE

Using multiple monitors significantly increases the amount of computing resources necessary to run the
application and may affect performance.

To open Live View in multiple monitors:

1. Click and then click to create a Live View tab.
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2. Click and drag the tab outside of the client window to create a new window. You can
drag the window to one of the secondary monitors.

Result

17.3 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them using the client.

NOTE

You must ensure the PTZ camera is properly connected to your system and your system is configured
to detect it before you can control them using the client.

To control PTZ cameras:

• Click the display area with the PTZ cameras and use the on-screen PTZ controls.

PTZ controls:
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1. Open menu: Click to open camera OSD menu controls. This feature may not be sup-
ported for all camera models.

2. Move camera: Click the arrows to move the camera.

Click to open dynamic zoom mode. Then click and drag in the video area to
zoom in the camera on an area.

3. Zoom +/-: Click to zoom the camera in and out.
4. Focus +/-: Click to increase/decrease the focus.
5. Iris +/-: Click to increase/decrease the iris.
6. Advanced: Click to access advanced PTZ controls.

17.3.1 PTZ Presets

Presets will save a camera position for quick retrieval.

To add presets:

1. Click to open the Advanced controls. Select Preset.

2. Click .

3. Select the number of the preset you would like to add.

4. Move the camera to the desired position.

5. Click to save the current position as a preset.

To go to a saved preset:

1. Select the preset number from the list or click to go to the currently selected
preset.

17.3.2 PTZ Tours

Tours will cycle through a set of presets.

To configure a PTZ tour:

1. Click to open the Advanced controls. Select Tour.
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2. Click .

3. Under Cruise ID, select the number of the tour you would like to configure.
4. (Optional) Under Cruise Name, enter a name for the tour.

5. Use the chart to select which presets you would like to include in the tour and the or-
der of presets.

• Preset: Select the preset number.
• Time(s): Enter the time in seconds the camera will remain on the selected preset.

• Operation: Click to add a preset to the tour. Click to delete a preset from
the tour.

6. Click OK to save changes.

To run a PTZ tour:

1. Select the tour number and click .

17.3.3 PTZ Pattern

Patterns automatically cycle the camera between two positions.

To create a pattern:

1. Click to open the Advanced controls. Select Pattern.

2. Select the number of the pattern you would like to set up.

3. Move the camera into the desired start position.
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4. Click to start recording the pattern.

5. Move the camera to the desired end position. Then, click to stop recording the
pattern.

To run a pattern:

1. Select the pattern number and click .

17.3.4 PTZ Scan

Scan automatically cycles between a left and right point.

To set up scan mode:

1. Click to open the Advanced controls. Select Scan.

2. Move the camera to the desired left position and click .

3. Move the camera to the desired right position and click .

To run scan mode:

1. Click .

17.3.5 PTZ Pan

Pan makes the camera continuously pan 360°.

To run Pan mode:

1. Click to open the Advanced controls. Select Pan.

2. Click .

17.4 Playback

You can use Playback mode to playback video saved on systems connected to the client.

To access Playback mode:

• Click and then click to create a Playback tab.
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To playback video:

1. Check the channels you would like to play back from in the Device List.
2. Under Type, check the file types you would like to search for.

• All: All recordings.
• General: Continuous recordings.
• MD: Motion recordings.
• Alarm: Alarm recordings. Your system must support alarm devices (not included)
to use this feature.

3. Under Stream, selectMain Stream to search for Main Stream recordings (high qual-
ity) or Sub Stream to search for Sub Stream recordings (smaller file size).

4. Select the start time and end time for your search under From and To. You may not
search more than 24 hours of video.

5. Click Search. Wait for the client to find video saved to the system.
6. Click inside the play back bar to start playback.
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17.5 Playback Controls

1. Display area: Double-click to expand/return to split-screen mode. Hold the mouse
over the display area to open the camera toolbar.

• Snapshot: Click to save a snapshot.

• Digital zoom: Click to enable digital zoom mode. Then, click and drag to

zoom in. Click and drag to pan the camera. Click again to zoom out.

2. Event: Click to view recordings based on a list of events and files.
3. Record: Click to view recordings on a timeline.
4. Sync: Click to sync playback between channels. This forces all channels to playback

from the same time.
5. Pause/play.
6. Stop.
7. Frame-by-frame: Click to advance the video by a single frame.
8. Playback speed: Use the slider to adjust the playback speed.
9. Mute.
10.Volume.
11.Split-screen: Select split screen configuration.
12. Full-screen: Click to open playback in full-screen. Press ESC to exit full-screen.
13. Timeline zoom: Use the slider to zoom in/out on the timeline.
14.Playback timeline: Shows recordings from the selected channels on a timeline.

Click inside the timeline to start playback or select a playback time. Each type of re-
cordings is shown in a different color. Continuous recordings are green, motion re-
cordings are yellow, and alarm recordings are red.

15.Video clip: Click to start a video clip. You can download video clips to your hard
drive.

16.Download list: Click to see a list of files you have downloaded and the progress of
files that are currently downloading.

17.Search: Search for video on the selected channels based on the search parameters
you set.
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18.Device list: Select the channels you would like to search or playback video from.

17.6 Downloading Video to your Computer Hard Drive

You can download video to your computer hard drive to save important events or share
them. It is recommended to download video of important events as soon as possible to
ensure they are not overwritten by new recordings.

NOTE

PC Users: You may need to run FLIR Cloud™ Client as an administrator to download files to your hard
drive.

To download video files:

1. Start playing back video using the steps in 17.4 Playback, page 83.

2. Click to start a video clip at the current playback time. Click to stop the video
clip.

3. Configure the following save options:

• Path: Use the default save folder or click Browse to select a different folder.
• File Format: Select Original Format to save to .dav format (requires the video
player). Select AVI to save files to .avi format (can be played in VLC Media Player).

NOTE

The Mac version only supports downloading video to .dav format.

• Download Video Player: Check to save a copy of the video player with the down-
loaded file.

4. Click OK to start the download. A status screen will pop up to show progress on
downloaded files.

NOTE

To retrieve downloaded video files:

• PC Users: Browse to the folders listed in General>File.
• Mac Users: Browse to the folders listed in General>File. To get to the default location, open Appli-

cations in Finder, right click on FLIR Cloud Client and select Show Package Contents. Then, nav-
igate to the desired folder.

17.7 Alarm

The Alarm menu allows you to view a list of alarms received by the client software.

NOTE

You must set up alarms in the Alarm CFG menu before they will appear in this list. See 17.12 Alarm
CFG, page 91 for more details.
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To access Alarms:

• Click and then click .

Alarm menu overview:

1. Number of alarms: Shows the number of open alarms.
2. Alarm list: Shows the list of alarms and information on when they occurred and

which systems and channels triggered them.
3. Alarm Process: You can close alarms by selecting one of the options and clicking

OK.
4. Options: Check to enable the following:

• Display Link Video: Open live video to monitor alarms on a continuous basis.
• Display Overlay Window: Show the overlay controls. They allow you to enable/
disable sound alerts and quickly jump back to the Alarm menu from another tab.

• Pause Refresh: Stop refreshing the live video in the video popup.

17.8 Log

The Log menu allows you to view logs for the client software or to view logs for con-
nected systems.

To access logs:

• Click and then click .

To view client logs:

1. Click Client Log to view logs for the client software.
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2. Configure the following:

• Start Time/End Time: Select the start and end times to search for logs.
• Log Type: Select the type of logs to search for.

3. Click Search.

To view logs from connected systems:

1. Click Device Log to view logs from connected systems.

2. Configure the following:

• Start Time/End Time: Select the start and end times to search for logs.
• Log Type: Select the type of logs to search for.
• Device Name: Select the system you would like to view logs from.

3. Click Search.

17.9 E-map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To create an E-map:

1. Click and then click .

2. Click Add Map.
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3. Configure the following:

• Name: Enter a name for your e-map of your choice.
• Picture: Click File and then select a .png, .bmp, or .jpg image on your computer
to use as the e-map.

• Describe (optional): Enter a text description of the e-map.

4. Click Save.
5. Click Edit to edit the e-map.

6. Click and drag cameras from the device list to place them on the map.

To open cameras from the e-map:

1. Click View.
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2. Double-click cameras on the map to open live video.

17.10 Devices

The Devices menu is where you can manage systems connected to the client software.

To access the Devices menu:

• Click and then click .

Devices overview:

1. Devices Found: Shows systems that are connected to the same network as the
computer where the client is installed. Once you connect to the system, it moves to
the bottom of the screen.

2. Search: Refresh the list of systems connected to the network.
3. Add: Add checked systems to the client software.
4. Device list: Shows a list of systems connected to the client software, and shows

which systems are online.
5. Add Device: Add a remote system using a Device ID or IP/DDNS address.
6. Delete: Delete the selected system.
7. Import: Import a list of systems from a saved .xml file.
8. Export: Export a list of currently connected systems to an .xml file. This is useful if

you need to re-install the software or if you want to open the same list of systems on
a different computer.

9. Delete: Delete system.
10.Manual connect/disconnect: Manually connect/disconnect the system.
11.Edit: Edit the connection details for the system.

17.11 Device Config

The Device Config menu allows you to remotely configure settings for connected
systems.
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To access the Device Config menu:

• Click and then click .

• Click on a system in the device list to see the settings available for that system and
then configure settings as needed.

NOTE

The settings available depend on the model of system you have.

17.12 Alarm CFG

The Alarm CFG menu allows you to configure alarms for the client software. The client
software will alert you by popping up live video and playing sound alerts.

NOTE

Alarm upload must be enabled on the system in order for it to send the alarm to the client software.

To create alarms:

1. Click and then click .

2. Click Add to create a new alarm.
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3. In the Alarm sourcesmenu, you set up the parameters that trigger the alarm.

• Under Alarm Type, select the alarm type that will trigger an alarm. For example,
you can select Motion Detect for the alarm to be triggered by motion.

• Select the systems or channels you would like to trigger an alarm. Continuing the
example, if CAM 1 is selected, the alarm will be triggered if there is motion on
CAM 1.

• Click Next.

4. In the Alarm link menu, you set up the responses to alarms. Select the channels that
will pop up or alarm out devices (not included; not all systems support alarm out devi-
ces) that will be triggered by an alarm.
For each channel selected, configure the following:

• Video: Pop up a window with live video from the selected channel, like the one
below.

• Record: Record video from the selected channel.

NOTE

PC Users: You may need to run the client software as admin to record.

• Preset: If you select a PTZ camera, you can select the preset that will be activated
when an alarm occurs.

• Stay Time: Enter how many seconds the video window will stay open or record
when an alarm occurs.
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5. Click Next.
6. In the Period window, configure times the alarm will be activated.

7. Click Confirm to save the alarm.

To manage alarms:

1. Export: Export current list of alarms as an xml file.
2. Import: Import list of alarms.
3. Delete: Delete selected alarm.
4. Add: Add new alarm.
5. Alarms.
6. On/off: Click to enable/disable alarm.
7. Delete: Click to delete alarm.
8. Edit: Click to edit alarm settings.

17.13 Tour & Task

The Tour & Task menu is where you can set up custom views for the system. You can al-
so set up tours, which sets the client to automatically cycle through views.

To start a tour:

• Click in Live View to start a tour. The live view will automatically cycle through all
views you have set up in the Tour & Task menu. Click again to stop the tour.

To add views:

1. Click and then click .
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2. Click + to create a new view.

3. Under Name, enter a name for your view.
4. Under Stay Time, enter the number of seconds the view will be shown before the cli-

ent switches to the next view.
5. Select the split-screen mode you would like to use for the view and then click and

drag channels to the empty grid areas to select channels to be shown in the view.

6. Click Save to save the view. Or click Add More to save the view and create another
view.

17.14 Account

The Account menu is where you can set up user accounts and passwords for the client
software. To simplify management, you can group user accounts according to role. A role
determines the permissions an individual user account can have.

To access the account menu:

• Click and then click .

17.14.1 Managing User Accounts

By default, the client software includes an admin account that has full access to all fea-
tures of the software and all connected systems. You can add user accounts with cus-
tomized levels of access.

NOTE

The admin account cannot be deleted. The default user name for the admin account is admin and the
default password is admin.
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To create a user account:

1. Click Add.

2. Configure the following settings for the user account:

• User Name: Enter a user name for the account.
• Role: Select the role for the user account. By default, the user account gains all
the permissions of the role selected, but you can deactivate permissions as
needed.

• Password/Confirm Password: Enter the password for the user account.
• Remarks (Optional): Enter a text description of the user account.
• User Rights: Check the permissions that will apply to the user account. If you
click on LiveView, Playback, and PTZ, you can select which channels the user ac-
count can access in the Channel List section.

3. Click Save to create the account.

To switch between user accounts:

• Click .

To modify a user account:

NOTE

Admin accounts with Account Setup permissions can change account passwords. A user cannot
change his own password.

• Click next to the user account you would like to modify. Edit the user account de-
tails and click Save.

To delete a user account:

1. Click next to the user account you would like to delete. Click OK to confirm.
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17.14.2 Managing Roles

Roles make it easier to manage user accounts by determining the permissions an indi-
vidual user account can have. By default, a new user account is given all the permissions
of the role they are assigned to.

To create a role:

1. Click the Role tab.
2. Click Add.

3. Configure the following settings for the role:

• Role Name: Enter a name for the role.
• Remarks (Optional): Enter a text description of the role.
• Role Rights: Check the permissions that will apply to user accounts assigned this
role. If you click on LiveView, Playback, and PTZ, you can select which channels
may be accessed in the Channel List section.

4. Click Save.

To modify a role:

• Click next to the role you would like to modify. Edit the role details and click Save.

To delete a user account:

1. Click next to the role you would like to delete. Click OK to confirm.

17.15 General

The General menu is where you can configure application settings for the client software.

To access the General menu:

• Click and then click .
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17.15.1 Basic

The Basic menu contains general settings for the client software.

The Basic menu contains the following settings:

• Log Saved Time: Select the number of days you would like the client to save log
entries.

• Instant Playback Time: Select the number of minutes the system will go back when
you start an instant playback.

• Network Capability: Select the speed of your computer’s network connection.
• Resume Live View State: Check for the client to resume live view when it starts up.
The live view will open to the last view that you had open.

• Auto login application: Check for the client to automatically login when it starts up
without entering a user name or password.

• Auto Login Windows: Not supported.
• Language: Select the language for the client software.
• Sync Time: Check to have the client software sync time with your computer’s system
time. Select the time the software will sync the time. Click Sync Now to manually sync
the time.

• Time Format: Select 12–Hour or 24–Hour time format. You must close the client and
restart it to apply this setting.

NOTE

Click Save to save setting changes.

17.15.2 File

The File menu allows you to select the folders where the client software will save down-
loaded video files and snapshots.
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The File menu contains the following options:

• Snapshot Path: Click Browse to select the default folder to save snapshots.
• Record Path: Click Browse to select the default folder to save video recordings.
• Config Path: Click Browse to select the folder where the client will save software
config files.

NOTE

Click Save to save setting changes.

PC Users: You may need to run the client software as admin to save files to enable snapshot or video
recording.

17.15.3 Alarm Prompt

The Alarm Prompt menu allows you to configure audio alerts. The client will play audio
alerts when events occur. You can replace the default sounds with any .wav file.

NOTE

You must configure alarms in the Alarm CFG menu before the client will play alarm sounds.

The Alarm Prompt menu has the following options:

• Open Audio: Check to enable audio alerts.
• Loop: Check to repeat audio alerts until acknowledged.
• Camera Masking: Select or preview the sound that will play for camera masking
alarms.

• Motion Detect: Select or preview the sound that will play for motion detection.
• Video Loss: Select or preview the sound that will play for video loss alarms.
• Disk Full: Select or preview the sound that will play for disk full alarms.
• Disk Error: Select or preview the sound that will play for disk errors.
• External: Select or preview the sound that will play for external alarms (triggered by
sensor devices, which may not be supported on all systems).

• E-map flashes when alarm occurs: If the camera has alarms enabled and is added

to an e-map, a appears on the e-map when an event occurs.

NOTE

Click Save to save changes.

17.15.4 Version

The Version menu shows you which version of the client software you are using. It is rec-
ommended to always run the latest version of the software from www.flirsecurity.com/pro.
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Connecting to your System
Using Smartphone or Tablet
Apps

18

The system is compatible with iPhone, iPad and Android devices.

Platform App Name Get App From

iPhone/iPad FLIR Cloud™ Apple App Store

Android FLIR Cloud™ Google Play Store

See www.flirsecurity.com/pro for the latest list of supported apps and devices.

18.1 iPhone

FLIR Cloud™ is an iPhone app that allows you to remotely view your system.

18.1.1 Prerequisites

• Connect your system to your router using an Ethernet cable (included).
• Make sure to upgrade your system to the latest firmware version. You must have
the latest firmware and mobile apps to connect to the system over the Internet.

NOTE

For the latest list of supported apps and devices, visit www.flirsecurity.com/pro.

NOTE

The app will ask for permission to send push notifications and to access Photos. It will only send no-
tifications if you enable motion-activated push notifications in the Push Config menu. It needs ac-
cess to Photos to save snapshots and video clips to the local storage on your mobile device.

18.1.2 Connecting to your System on iPhone

1. Download FLIR Cloud™ for free from the App Store.

2. Tap on the FLIR Cloud™ icon ( ) to start the app.

3. Tap Sign up and enter your email address and password to create a new account.

4. Tap then .

5. Configure the following:
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5.1. Tap Scan QR Code and line up the QR code on the top of your system using
the camera on your mobile device.

OR

Under Device ID, manually enter the Device ID printed on the label.

5.2. Name: Choose a name for your system of your choice.
5.3. Client Port: Enter the Client Port (default: 35000).
5.4. User Name: Enter the system’s User Name (default: admin).
5.5. Password: Enter the system’s Password (default: 000000).

6. Tap Connect. You will be prompted to change the system password.
7. Enter a new 6 character password and tap OK. This password will be used to log on

to your system from now on.
8. The app opens in Live View and streams video from your cameras.

18.1.3 Live View Interface

You can use FLIR Cloud™ in portrait and landscape mode.

Live View Overview

1. Menu: Tap to bring up the Menu.
2. Display Area: Double-tap to open a channel in full screen. Swipe left or right to se-

lect a different page of channels.
3. Pages: Shows the number of pages available and highlights the currently selected

page.
4. Split: Select the split-screen layout.
5. Snapshot: Tap to take a snapshot from the currently selected channel.
6. Control Bar: Contains the following options. Swipe left or right to access more

options.
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6.1. Quick Playback: Tap to start/stop quick playback.
6.2. PTZ Controls: Open/close PTZ controls. PTZ camera required (not included).
6.3. Streaming Quality: Open/close streaming quality panel.
6.4. Not supported.
6.5. Not supported.
6.6. Not supported.
6.7. Digital Zoom: Tap to activate digital zoom mode. Pinch to zoom in/out.
6.8. Color Settings: Tap to access color controls for the currently selected

camera.

7. Manual record: Tap to start/stop manual recording.
8. Access Favorites.
9. Connect/disconnect all: Connect to/disconnect from all previously added cameras.
10.Device List: Tap to open a list of devices. You can use the Device List to open multi-

ple systems or cameras at once.

18.1.4 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them from the app.

To control PTZ cameras:

1. Tap the display area the PTZ camera is connected to.

2. Tap to open PTZ controls.

PTZ Controls

1. Live Display: Swipe to move the camera. Pinch to zoom in/out.
2. Focus: Tap to show focus controls.
3. Zoom: Tap to show zoom controls.
4. Iris: Tap to show iris controls.
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5. Goto preset: Tap to access preset controls. Then use the sliders to select a preset
and then tap the checkmark to goto the preset.

NOTE

You must set presets for the camera using the system’s local menus before you can use this
feature.

18.1.5 Viewing Snapshots and Videos with Local Files

If you have saved snapshots or videos using the app, you may open them with Local
Files.

To access Local Files:

• Tap to access the Menu, and then tap Local Files.
Local Files Overview

1. Menu: Return to Menu.
2. Files: Tap to open files.
3. File Type: Tap the options to select video files or snapshots.
4. Options: Tap to delete or export files to your device’s local storage.

NOTE

Exported snapshots and video files are saved to the Photos app. Video files are saved to MP4
format.

18.1.6 Using Playback Mode on iPhone

You can access recorded video on your system using your iPhone.

NOTE

You must enable Sub Stream Recording to use playback mode on mobile devices.

To use Playback Mode:

1. Tap to access the Menu, and then tap Playback.
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2. Tap + and select a channel to playback.

3. Select the date then the start and end times to playback.
4. Use the on-screen controls to control playback.

Playback Controls

4.1. Display Area: Double-tap to open in full-screen.
4.2. Play/pause.
4.3. Time Bar: Tap inside the bar to fast forward or rewind.
4.4. Previous: Select previous video file.
4.5. Next: Select next video file.
4.6. Snapshot: Tap to take a snapshot from the selected camera.
4.7. Stop All: Stop playback on all channels.
4.8. Not supported.
4.9. Manual Record: Tap to start/stop recording to your mobile device’s local

storage.
4.10. Fast.
4.11. Slow.
4.12. Time Range: Tap to change the range of time shown in the time bar.
4.13. Next frame.

18.1.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device
when one of your cameras detects motion. Once you have received a push notification,
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you can select it to open live video or a snapshot attachment from the camera that de-
tected motion.

NOTE

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. Tap to access the Menu, and then tap Push Config.

2. Tap the system you would like to configure.
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3. TapMotion Detect and then check each channel you would like to receive push noti-
fications from.

4. Tap to save changes. You will now receive a notification when one of the selected
cameras detect motion.

18.1.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

NOTE

You must configure push notifications before you can use the Event List.

To access the Event List:

• Tap to access the Menu, and then tap Event List.
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Event List Overview

1. Events: Shows the details of each motion detection event. Tap the event to view the
video or snapshot.

2. Delete All: Tap to delete all events in the Event List.

NOTE

To delete a single event, swipe it to the left and then tap Delete.

3. View: Tap to view the video or snapshot for the selected event.

18.1.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly
bring up the group of cameras in Live View without having to individually select each
camera.

To use Favorites:

1. Tap to access the Menu, and then tap Favorites.

2. Tap a group to configure an existing group.

NOTE

Tap to create a new group and then enter a name for the new group.

3. To add cameras to the group, tap .
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4. Select the cameras you would like to add to the group. Tap to save changes.

NOTE

To delete cameras that have been added to the group, select the group in the group list. Then,
swipe left and tap Delete.

To open Favorites in Live View:

1. Tap to access the Menu, and then tap Live View.

2. Tap , and then tap to open the group.

18.1.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. Tap to access the Menu, and then tap E-Map.
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2. Tap .

3. Select a .jpg image on your mobile device.

4. Press and select a camera. Drag the camera on the screen to place it on the
map. Repeat to add additional cameras.

5. Click . Choose a name for your E-Map and then tap OK.

To open cameras from an E-Map:

1. Tap in Live View.

#LX400022; r.16694/30364; en-US 109



Connecting to your System Using Smartphone or Tablet Apps18

2. Select the E-Map in the Device List.

3. Tap the camera or cameras to select and then tap Connect to open the cameras.

18.1.11 Device Manager

You can use Device List to add, delete, or edit your systems.

To access Device Manager:

• Tap to access the Menu, and then tap Device Manager.

To edit a system:

1. Tap the system in Device Manager. Tap .

2. Edit the connection details as needed.
3. Tap Connect to save changes and connect to the system.

To delete a system:

1. Tap the system you would like to delete.
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2. Tap . Tap OK to confirm.

18.1.12 Adding Devices Using an IP or DDNS Address (Advanced)

The app can connect directly to a device via the IP address or DDNS address as an op-
tional advanced connectivity method or for systems that do not support FLIR Cloud™.

Prerequisites:

• The device you are connecting to must be connected to the Internet.
• You must port forward the HTTP Port (default: 80) and Client port (35000) on your
router to the device’s local IP address.

• To ensure connectivity, it is highly recommended to register for a free DDNS domain
to use with your system.

• For more information on port forwarding and DDNS, visit www.flirsecurity.com/pro.

To add a device using an IP or DDNS address:

1. Tap then .

2. Configure the following:

2.1. Tap Register Mode and select IP/Domain.
2.2. Name: Choose a name for your system of your choice.
2.3. Address: Enter the IP address or DDNS address of your system.
2.4. Client Port: Enter the Client Port (default: 35000).
2.5. User Name: Enter the system’s User Name (default: admin).
2.6. Password: Enter the system’s Password (default: 000000).

3. Tap Connect. You will be prompted to change the system password.
4. Enter a new 6 character password and tap OK. This password will be used to log on

to your system from now on.
5. The app opens in Live View and streams video from your cameras.
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18.2 iPad

FLIR Cloud™ is an iPad app that allows you to remotely view your system.

18.2.1 Prerequisites

• Connect your system to your router using an Ethernet cable (included).
• Make sure to upgrade your system to the latest firmware version. You must have
the latest firmware and mobile apps to connect to the system over the Internet.

NOTE

For the latest list of supported apps and devices, visit www.flirsecurity.com/pro.

NOTE

The app will ask for permission to send push notifications and to access Photos. It will only send no-
tifications if you enable motion-activated push notifications in the Push Config menu. It needs ac-
cess to Photos to save snapshots and video flips to the local storage on your mobile device.

18.2.2 Connecting to your system on an iPad

1. Install FLIR Cloud™ for free from the App Store.

2. Tap on the FLIR Cloud™ icon ( ) to start the app.

3. Tap then .

4. Tap Device Manager.
5. Tap Add.

6. Configure the following:
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6.1. Tap Start Scanning and line up the QR code on the top of the system using
the camera on your device.

OR

Under Device ID, manually enter the Device ID printed on the label.

6.2. Name: Choose a name for your system of your choice.
6.3. Client Port: Enter the Client Port (default: 35000).
6.4. User Name: Enter the system’s User Name (default: admin).
6.5. Password: Enter the system’s Password (default: 000000)
6.6. Channel Amount: Enter the number of channels your system has.

7. Tap Start Live View. You will be prompted to change the system password.
8. Enter a new 6 character password and tap OK. This password will be used to log on

to your system from now on.
9. The app opens in Live View and streams video from all connected cameras.

18.2.3 Live View Interface

You can use FLIR Cloud™ in landscape or portrait mode.
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Live View Overview

1. Display area: Double-tap to open camera in full screen.
2. Favorites: Slide to select favorites.
3. Disconnect: Disconnect from all open cameras.
4. Add to favorites: Add the current view to favorites.
5. Shapshot: Tap to take a snapshot from the currently selected channel.

NOTE

You can view or share snapshots using the Photos app.

6. Change display view.
7. Not supported.
8. Manual record: Tap to start/stop manual recording from this channel.
9. Not supported.
10.Open menus.
11.Select different camera.

18.2.4 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them using the app.

To control PTZ cameras:

1. In Live View, tap the window the PTZ camera is connected to.
2. Slide the middle controls to the right to access PTZ controls.
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PTZ Controls

1. Live display: Swipe to move the camera. Pinch to zoom in/out.
2. Direction buttons: Tap to move the camera.
3. Zoom: Tap to zoom the camera in/out.
4. Focus: Tap +/- to adjust the focus.
5. Iris: Tap +/- to adjust the iris.
6. PTZ/EPTZ: Tap to switch between PTZ and EPTZ mode. Use PTZ mode to control

PTZ cameras. Use EPTZ mode to activate digital zoom mode on non-PTZ cameras.
7. Goto preset: Tap to goto a camera preset.

NOTE

You must set presets for the camera using the system’s local menus before you can use this
feature.

18.2.5 Using Playback Mode on iPad

You can access recorded video on your system using your iPad.

NOTE

You must enable Substream Recording to use playback mode on mobile devices.

To use Playback Mode:

1. From Live View tap then .
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2. In Portrait Mode: Tap +, select the start time and end time for your search, and select
the camera you would like to playback.
OR

In Landscape Mode: Select the start time and end time for your search, and drag the
camera you would like to playback to the display area.

3. Use the playback controls.

Playback Controls

1. Display area: Double-tap to open camera in full screen.
2. Play/pause.
3. Previous file.
4. Disconnect: Disconnect from the currently selected camera.
5. Not supported.
6. Snapshot: Tap to take a snapshot from the currently selected camera.
7. Change display view.
8. Menu.
9. Next file.
10. Time range: Tap to change the range of time shown in the time bar.
11. Time Bar: Tap inside the bar to fast forward or rewind.

NOTE

Playback controls are only shown in portrait mode.
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18.2.6 Using Local File to View Manual Recordings

You can view manual recordings saved to your mobile device using the Local File menu.

To view manual recordings:

1. From live view, tap then .

2. Tap Local Files.
3. Tap a video file to open it.

To delete videos:

1. Tap Edit.

2. Select the videos you would like to delete and tap .

18.2.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device
when one of your cameras detects motion. Once you have received a push notification,
you can select it to open video or an image from the camera that detected motion.
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NOTE

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. From live view, tap then .

2. Tap Push Config.
3. Tap the slider for the system you would like to configure.
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4. TapMotion Detect then check each channel you would like to receive push notifica-
tions from.

5. Under Type, select Playback to attach a video file with each push notification. Or, se-
lect Picture to attach a still image of the camera that detected motion.

6. Tap OK to save changes. Whenever the selected cameras detect motion, you will re-
ceive a notification.

18.2.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

NOTE

You must configure push notifications before you can use the Event List.

To access the Event List:

1. From live view, tap then .

18.2.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly
bring up the group of cameras in Live View without having to individually select each
camera.
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To create favorites:

1. In Live View, tap to save the cameras that are currently open as a favorite.

2. Enter a name for the favorite and tap OK.

To open favorites in Live View:

• In Live View, slide the dial to cycle through favorites.

To edit favorites:

1. From live view, tap then .

2. Tap Favorites.
3. Tap the favorite you would like to edit.

4. Tap Edit.
5. Select the cameras you would like to include in the favorite and then tap Save.

18.2.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. From live view, tap then .
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2. Tap Add.

3. Select a .jpg image file on your mobile device.

4. To edit the E-map:

4.1. Select Image: Select a different image file to use for your E-Map.
4.2. Add Camera: Tap + to select cameras to add to your E-Map. Then drag the

camera to place it on the E-Map.
4.3. Delete E-Map.

5. When you are finished editing the E-Map, tap Save and enter a name for the E-Map
to save changes.

To open cameras using the E-Map:
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1. In live view, tap + on an empty display window and select the E-Map.

2. Tap a camera from the E-map to open.

18.2.11 Using the Device Manager

Device Manager allows you to manage your systems.

To access Device Manager:

1. From live view, tap then .

2. Tap Device Manager.

To delete a system:

1. Tap the system to select it.

2. Tap . Tap Yes to confirm.
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To modify a system:

1. Tap a system to select.
2. Tap the system again to open the edit screen.
3. Update the connection details as needed and then tap Start Live View.

18.2.12 Adding Devices Using an IP or DDNS Address (Advanced)

The app can connect directly to a device via the IP address or DDNS address as an op-
tional advanced connectivity method or for systems that do not support FLIR Cloud™.

Prerequisites:

• The device you are connecting to must be connected to the Internet.
• You must port forward the HTTP Port (default: 80) and Client port (default: 35000) on
your router to the device’s local IP address.

• To ensure connectivity, it is highly recommended to register for a free DDNS domain
to use with your system.

• For more information on port forwarding and DDNS, visit www.flirsecurity.com/pro.

To add a device using an IP or DDNS address:

1. Install FLIR Cloud™ for free from the App Store.

2. Tap on the FLIR Cloud™ icon ( ) to start the app.

3. Tap then .

4. Tap Device Manager.
5. Tap Add.

6. Configure the following:

tomsmith.myddns-flir.com
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6.1. Tap Register Mode and select IP/Domain. Then tap New Device to return to
the New Device screen.

6.2. Name: Choose a name for your system of your choice.
6.3. Address: Enter the DDNS or IP address of your device.
6.4. Client Port: Enter the Client Port (default: 35000).
6.5. User Name: Enter the system’s User Name (default: admin).
6.6. Password: Enter the system’s Password (default: 000000)
6.7. Channel Amount: Enter the number of channels your system has.

7. Tap Start Live View. You will be prompted to change the system password.
8. Enter a new 6 character password and tap OK. This password will be used to log

on to your system from now on.
9. The app opens in Live View and streams video from all connected cameras.
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18.3 Android

FLIR Cloud™ allows you to remotely view your system on Android devices.

18.3.1 Prerequisites

• Connect your system to your router using an Ethernet cable (included).
• Make sure to upgrade your system to the latest firmware version. You must have
the latest firmware and mobile apps to connect to the system over the Internet.

NOTE

For the latest list of supported apps and devices, visit www.flirsecurity.com/pro.

18.3.2 Connecting to your System on Android

1. Download FLIR Cloud™ for free from the Google Play Store.

2. Tap on the FLIR Cloud™ icon ( ) to start the app.

3. Tap Sign up and enter your email address and password to create a new account.

4. Tap then .

5. Configure the following:

5.1. Tap Scan QR Code and line up the QR code on the top of your system using
the camera on your mobile device.

OR

Under Device ID, manually enter the Device ID printed on the label.

5.2. Name: Choose a name for your system of your choice.
5.3. Client Port: Enter the Client Port (default: 35000).
5.4. User Name: Enter the system’s Username (default: admin).
5.5. Password: Enter the system’s Password (default: 000000).
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6. Tap Connect. You will be prompted to change the system password.
7. Enter a new 6 character password and tap OK. This password will be used to log on

to your system from now on.

8. The app opens in Live View and streams video from your cameras.

18.3.3 Live View Interface

You can use FLIR Cloud™ in portrait and landscape mode.

Live View Overview

1. Menu: Tap to bring up the Menu.
2. Display Area: Double-tap to open a channel in full screen. Swipe left or right to se-

lect a different page of channels.
3. Pages: Shows the number of pages available and highlights the currently selected

page.
4. Split: Select the split-screen layout.
5. Snapshot: Tap to take a snapshot from the currently selected channel.
6. Control Bar: Contains the following options. Swipe left or right to access more

options.

6.1. Quick Playback: Tap to start/stop quick playback.
6.2. PTZ Controls: Open/close PTZ controls. PTZ camera required (not included).
6.3. Streaming Quality: Open/close streaming quality panel.
6.4. Not supported.
6.5. Not supported.
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6.6. Not supported.
6.7. Digital Zoom: Tap to activate digital zoom mode. Pinch to zoom in/out.
6.8. Color Settings: Tap to access color controls for the currently selected

camera.

7. Manual record: Tap to start/stop manual recording.
8. Access Favorites.
9. Connect/disconnect all: Connect to/disconnect from all previously added cameras.
10.Device List: Tap to open a list of devices. You can use the Device List to open multi-

ple systems or cameras at once.

18.3.4 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them from the app.

To control PTZ cameras:

1. Tap the display area the PTZ camera is connected to.

2. Tap to open PTZ controls.

PTZ Controls

1. Live Display: Swipe to move the camera. Pinch to zoom in/out.
2. Focus: Tap to show focus controls.
3. Zoom: Tap to show zoom controls.
4. Iris: Tap to show iris controls.
5. Goto preset: Tap to access preset controls. Then use the sliders to select a preset

and then tap the checkmark to goto the preset.

NOTE

You must set presets for the camera using the system’s local menus before you can use this
feature.

18.3.5 Viewing Snapshots and Videos with Local Files

If you have saved snapshots or videos using the app, you may open them with Local
Files.
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To access Local Files:

• Tap to access the Menu, and then tap Local Files.

1. Menu: Return to Menu.
2. Files: Tap to open files.
3. File Type: Tap the options to select video files or snapshots.
4. Options: Tap to share, delete, or export files to your device’s local storage.

NOTE

Exported video files are saved to MP4 format in the folder /snapshot/mp4/, which you can ac-
cess by connecting your Android device to a computer using a USB cable.

18.3.6 Using Playback Mode on Android

You can access recorded video on your system using your Android.

NOTE

You must enable Sub Stream Recording to use playback mode on mobile devices. For details on ena-
bling Sub Stream Recording, see 11.3 Setting up Scheduled or Manual Recording, page 24.

To use Playback Mode:

1. Tap to access the Menu, and then tap Playback.

2. Tap + and select a channel to playback.

3. Select the date then the start and end times to playback.
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4. Use the on-screen controls to control playback.
Playback Controls

4.1. Display Area: Double-tap to open in full-screen.
4.2. Play/pause.
4.3. Time Bar: Tap inside the bar to fast forward or rewind.
4.4. Previous: Select previous video file.
4.5. Next: Select next video file.
4.6. Snapshot: Tap to take a snapshot from the selected camera.
4.7. Stop All: Stop playback on all channels.
4.8. Not supported.
4.9. Manual Record: Tap to start/stop recording to your mobile device’s local

storage.
4.10. Fast.
4.11. Slow.
4.12. Time Range: Tap to change the range of time shown in the time bar.
4.13. Next frame.

18.3.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device
when one of your cameras detects motion. Once you have received a push notification,
you can select it to open live video or a snapshot attachment from the camera that de-
tected motion.
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NOTE

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. Tap to access the Menu, and then tap Push Config.

2. Tap the system you would like to configure.

3. TapMotion Detect and then check each channel you would like to receive push noti-
fications from.

4. Under Push type, select Video to attach a video clip to each push notification. Or,
select Image to attach an image to each push notification.

5. Tap to save changes. You will now receive a notification when one of the se-
lected cameras detect motion.

18.3.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

NOTE

You must configure push notifications before you can use the Event List.
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To access the Event List:

• Tap to access the Menu, and then tap Event List.

Event List Overview

1. Events: Shows the details of each motion detection event. Long press an event to
delete just that event.

2. Delete All: Tap to delete all events in the Event List.
3. View: Tap to view the video or snapshot for the selected event.

18.3.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly
bring up the group of cameras in Live View without having to individually select each
camera.

To use Favorites:

1. Tap to access the Menu, and then tap Favorites.

2. Tap a group to configure an existing group.

NOTE

Tap to create a new group and then enter a name for the new group.

3. To add cameras to the group, tap .

4. Select the cameras you would like to add to the group. Tap to save changes.

NOTE

To delete cameras that have been added to the group, select the group in the group list. Then,
press and hold to delete cameras from the group.

To open Favorites in Live View:
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1. Tap to access the Menu, and then tap Live View.

2. Tap , and then tap to open the group.

18.3.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. Tap to access the Menu, and then tap E-Map.

2. Tap .

3. Select a .jpg image on your mobile device.
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4. Press and select a camera. Drag the camera on the screen to place it on the
map. Repeat to add additional cameras.

5. Click . Choose a name for your E-Map and then tap OK.

To open cameras from an E-Map:

1. Tap in Live View.

2. Select the E-Map in the Device List.

3. Tap the camera or cameras to select and then tap Connect to open the cameras.
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18.3.11 Device Manager

You can use Device List to add, delete, or edit your systems.

To access Device Manager:

• Tap to access the Menu, and then tap Device Manager.

To edit a system:

1. Tap the system in Device Manager. Tap .

2. Edit the connection details as needed.
3. Tap Connect to save changes and connect to the system.

To delete a system:

1. Tap the system you would like to delete.

2. Tap . Tap OK to confirm.

18.3.12 Adding Devices Using an IP or DDNS Address (Advanced)

The app can connect directly to a device via the IP address or DDNS address as an op-
tional advanced connectivity method or for systems that do not support FLIR Cloud™.

Prerequisites:

• The device you are connecting to must be connected to the Internet.
• You must port forward the HTTP Port (default: 80) and Client port (default: 35000) on
your router to the device’s local IP address.

• To ensure connectivity, it is highly recommended to register for a free DDNS domain
to use with your system.

• For more information on port forwarding and DDNS, visit www.flirsecurity.com/pro.

To add a device using an IP or DDNS address:

1. Tap then .

2. Configure the following:
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2.1. Tap Register Mode and select IP/Domain.
2.2. Name: Choose a name for your system of your choice.
2.3. Address: Enter the IP address or DDNS address of your device.
2.4. Client Port: Enter the Client Port (default: 35000).
2.5. Username: Enter the system’s User Name (default: admin).
2.6. Password: Enter the system’s Password (default: 000000).

3. Tap Connect. You will be prompted to change the system password.
4. Enter a new 6 character password and tap OK. This password will be used to log on

to your system from now on.

5. The app opens in Live View and streams video from your cameras.
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You can also view your system remotely using Internet Explorer (version 8 or later re-
quired). In order to view your system on Internet Explorer over the Internet, you must set
up DDNS and port forwarding.

NOTE

Remote viewing is only compatible with Internet Explorer. Mozilla Firefox, Opera, Safari, and other
browsers are not supported.

19.1 Prerequisites

• The HTTP Port (default: 80) and Client Port (default: 35000) must be port forwarded
to your router.

• You must create a DDNS account, and have the DDNS settings configured in your
NVR. For details, 20 DDNS Setup (Advanced), page 139.

• The NVR must have internet access.

To view your system using Internet Explorer:

1. Open Internet Explorer. It is recommended to select Run as Administrator when
opening Internet Explorer to ensure full functionality.

2. In the address bar, enter your system’s IP address or DDNS address followed by the
HTTP Port (default: 80). For example, http://192.168.1.1:80 or
http://tomsmith.myddns-flir.com:80.

NOTE

You MUST include http:// in order to access your system.

3. An attention bar appears at the top or bottom of the screen to prompt you to install
ActiveX plugins, click Install or Allow and follow the prompts to install the plugins.

4. Enter the system user name and password (by default admin / 000000).
5. Select LAN to connect using the main (high quality) stream. SelectWAN to use the

substream to conserve bandwidth and for improved performance when connecting
over the Internet.

6. Click Login to log in.
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7. Double click on cameras in the camera list to open them in live view.

19.1.1 IE Live Display Overview

NOTE

Some options are not available in WAN mode.

1. Cameras: Double-click cameras to open in live view.
2. Camera Controls:

2.1. Digital zoom: Click and drag to select the zoom area.
2.2. Manual record.
2.3. Snapshot.
2.4. Mute/unmute.
2.5. Close.

NOTE

Manual Recordings are saved to C:\RecordDownload. Snapshots are saved to C:\PictureDown-
load. You must select Run as Administrator when you open Internet Explorer to use these functions.
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1. Live View Controls:

• Start Talk: Click to enable 2–way audio.
• Instant Record: Not supported.
• Local Play: Open recorded or back up video files (.dav) saved on the local
computer.

2. Live View Toolbar:

2.1. Select image quality.
2.2. Fluency/latency.
2.3. Full-screen.
2.4. Select display view.

1. PTZ Controls.
2. Color Settings: Use the sliders to adjust the brightness, contrast, saturation, and

hue for the selected camera.

19.1.2 Using Search Mode in IE (Playback)

You can access recorded video from your NVR using the Internet Explorer client.

To access recorded video from your NVR:

1. Click Search.
2. Perform the following to start playback:

2.1. Select the date you would like to playback.
2.2. Select the channel or channels you would like to playback from. The time bar

will populate with times that have video available.
2.3. Click in side the time bar to start playback.
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Free DDNS service is available as an optional connectivity method to connect to your
system over the Internet.

NOTE

Except where noted, the instructions in this section are the same on PC or Mac.

20.1 Accessing your System within a Local Network (LAN)

You can connect to your system through using the Client Software through the local area
network (LAN). It is recommended to confirm connectivity over a local network before
setting up your system for DDNS connectivity.

NOTE

To complete the steps below, your computer must be on the same network as your system.

20.1.1 Step 1 of 3: Connect your System to Your Router

1. Power off your system by disconnecting the power adapter.
2. Connect an Ethernet cable (included) to the LAN port on the rear panel of the system.

Connect the other end of the Ethernet cable to an empty LAN port (usually numbered
1~4) on your router.

3. Reconnect the power adapter to power the system back on.
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20.1.2 Step 2 of 3: Obtain the System’s Local IPAddress

1. Right-click to open the Quick Menu and click Info. Enter the system user name (de-
fault: admin) and password (default: 000000).

2. Write down the IPAddress of the system.

• A local IP looks something like this: 192.168.5.118.

20.1.3 Step 3 of 3: Connect to the System’s Local IPAddress

Follow the steps below to confirm connectivity over a local network on a PC or Mac.

To connect using the system’s local IP address:

1. Download and install the client software.

• PC Users: Download and install the Client Software for PC from www.flirsecurity.
com/pro.

• Mac Users: Download and install the Client Software for Mac from
www.flirsecurity.com/pro. Double click to extract the software. Drag the software to
Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon ( ) from the
desktop or Applications list.

3. Log into the Client Software using the Client Software user name (default: admin)
and password (default: admin) and then click Login.
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4. The client scans your LAN for connected systems. Check your system (a) and click
Add (b).

5. Enter the password for your system (default: 000000) and click OK.
6. If this is the first time you are connecting, you will be prompted to change the system

password.

7. Enter a new 6 character password and click OK. This password will be used to con-
nect to your system from now on.

8. Click then .

#LX400022; r.16694/30364; en-US 141



DDNS Setup (Advanced)20

9. Click and drag Default Group to the display window to open your cameras in live
view.

Result

20.2 DDNS Setup—Access your System Remotely over the Internet

Setting up DDNS connectivity allows you to view your system from any computer or com-
patible mobile device with Internet access.

To set up remote connectivity with your system, you must:

1. Port forward the HTTP port (default: 80) and Client port (default: 35000) on your
router to your system’s IP address.

2. Create a DDNS account.
3. Enable DDNS on the system.
4. Test the remote connection by entering your DDNS address in the client software.

20.2.1 Step 1 of 4: Port Forwarding

Youmust port forward the HTTP port (default: 80) and Client port (default: 35000) on
your router to your system’s IP address before you can remotely connect to your system.
There are several methods to port forward your router:

• Use the Auto Port Forwarding Wizard (PC only) to port forward the required ports
(see www.flirsecurity.com/pro for details). For instructions, see the Auto Port Forward
Wizard manual on www.flirsecurity.com/pro.

• Manually port forward the required ports on your router to your system’s IP address by
following your router manufacturer’s instructions. For more information on port for-
warding, see the reference guides on www.flirsecurity.com/pro.

NOTE

If the above ports are not forwarded on your router, you will not be able to access your system remotely.
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20.2.2 Step 2 of 4: Create a DDNS Account

To setup your free FLIR DDNS account:

1. In your browser, go to http://ddns.myddns-flir.com and click Create Account.

2. Complete the Account Information fields with your personal information. Complete
theWarranty Information with your purchase details (optional).

3. Complete the System Information fields:

• Product License: Select your product model from the Product License drop down
menu (i.e. DNR400 Series).

• <Product Code> - <MAC Address>: Enter the MAC address of your system.

• To find the MAC address, right-click to open the Quick Menu and click Info.

• URL Request: Choose a URL for your DDNS connection (i.e. your name, your
company or business name, or anything of your choice).

4. Click Create New Account.
5. Your account information will be sent to you at the email Address you used in Step 2.

You will need this information for remote access to your system. Record your informa-
tion below:
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Domain name/URL Request:

DDNS User Name:

Device DDNS password:

20.2.3 Step 3 of 4: Enable DDNS on the System

To enable DDNS in your System:

1. Right-click and click Main Menu. Enter the system password if prompted.

2. Click and then click Network>DDNS.

3. Check Enable.
4. Under Domain Name, enter the Domain Name/URL Request your received in the

email after registering for DDNS.
5. Under User Name, enter your DDNS User Name.
6. Under Password, enter your DDNS Device password.
7. Click OK to save your settings.

NOTE

Please allow 10~15 minutes for the DDNS servers to update with your new DDNS address before
attempting to connect.

20.2.4 Step 4 of 4: Connect to the System’s DDNS Address

NOTE

Please allow 10~15 minutes for the DDNS servers to update with your new DDNS address before at-
tempting to connect.

To connect using the system’s DDNS address:

1. Download and install the client software on a remote computer.

• PC Users: Download and install the Client Software for PC from www.flirsecurity.
com/pro.

• Mac Users: Download and install the Client Software for Mac from
www.flirsecurity.com/pro. Double click to extract the software. Drag the software to
Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon ( ) from the
desktop.
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3. Log into the Client Software using the Client Software user name (default: admin)
and password (default: admin) and then click Login.

4. Click Add Device.

5. Enter the following:

#LX400022; r.16694/30364; en-US 145



DDNS Setup (Advanced)20

5.1. Check By IP/Domain to add a system using the DDNS address.
5.2. Device Name: Choose a name for your system of your choice.
5.3. IP/DDNS Address: Enter the Domain Name/URL Request you received in

the email when you registered for DDNS followed by .myddns-flir.com.

NOTE

For example, if your Domain Name/URL Request is tomsmith, enter tomsmith.myddns-flir.
com

5.4. Client Port: Enter the Client Port (default: 35000).
5.5. User Name: Enter the system User Name (default: admin).
5.6. Password: Enter the system Password (default: 000000).

6. Click Add. If this is the first time you are connecting, you will be prompted to change
the system password.
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7. Enter a new 6 character password and click OK. This password will be used to con-
nect to your system from now on.

8. Click then .

9. Click and drag Default Group to the display window to open your cameras in live
view.

Congratulations! You can now connect over the Internet to view and playback video on
your computer.
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You can connect PTZ cameras (not included) to the system. FLIR IP PTZ cameras can
accept PTZ commands directly through the Ethernet cable or you can connect PTZ cam-
eras to the RS485 connectors on the back of the system.

To connect a FLIR PTZ camera to the system:

1. Connect the camera Ethernet cable to one of the PoE Ports on the system.
OR

Connect the camera to the local network (LAN) and then add it to the NVR. See 6.11
Connecting Cameras to the Local Area Network (LAN), page 11 for details.

2. Right-click and click Main Menu. Enter the system user name (default: admin) and
password (default: 000000) if prompted.

3. Click >Setting>Pan/Tilt/Zoom.

4. Under Channel, select the channel your PTZ camera is connected to.
5. Under PTZ Type, select Remote . This allows the system to control the PTZ func-

tions over the Ethernet cable.
6. Click OK. You can now control your PTZ camera using the system.

To connect a PTZ camera to the system via RS485:

1. Connect the camera Ethernet cable to one of the PoE Ports on the system.
OR

Connect the camera to the local network (LAN) and then add it to the NVR. See 6.11
Connecting Cameras to the Local Area Network (LAN), page 11 for details.

2. Right-click and click Main Menu. Enter the system user name (default: admin) and
password (default: 000000) if prompted.
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3. Click >Setting>Pan/Tilt/Zoom.

4. Under Channel, select the channel your PTZ camera is connected to.
5. Under PTZ Type, select Local. This allows the system to control the PTZ functions

over RS485. Configure the following RS485 connection parameters for your camera:

• Protocol.
• Address.
• Baud Rate.
• Data Bit.
• Stop Bit.
• Parity.

NOTE

Check the instruction manual for your PTZ camera to determine the correct settings.

6. Click OK. You can now control your PTZ camera using the system.

21.1 Controlling a PTZ Camera (Local NVR)

1. In Live View, double-click the channel that has the PTZ camera connected to open in
full-screen.

2. Right-click and click PTZ. Enter the system user name and password if prompted.
The PTZ menu opens.

3. Use the on-screen PTZ controls to control the camera.

PTZ Controls

1. Direction keys: Click to pan and tilt the camera. Click SIT to stop the current action.
2. Mouse PTZ: Click to activate mouse PTZ mode. In mouse PTZ mode:

• Click and drag to move the camera.
• Use the scroll wheel to zoom in and out.
• Right-click to exit and return to normal PTZ controls.

3. Zoom/Focus/Iris: Click +/- to adjust the zoom, focus, and iris.
4. Advanced controls: Click to open advanced PTZ controls.
5. Speed: Enter the PTZ speed.
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21.2 Advanced PTZ Controls

Advanced PTZ controls can be used to save camera positions and cycle through various
positions, and automate camera actions.

To open advanced PTZ controls:

• Click the arrow in the PTZ control window to open advanced controls.

Advanced PTZ controls overview:

1. No.: Select the number of the action you want to perform.
2. Not supported.
3. PTZ camera menu: Click to open the camera’s OSD menu. This may not be sup-

ported on all camera models.
4. Preset: Click to call the selected preset.
5. Autopan: Click to start autopan. During autopan, the camera will continuously pan

360°.
6. Tour: Click to run the selected tour.
7. Flip: Click to flip the camera 180°.
8. Pattern: Click to run the selected pattern.
9. Reset: Click to move the camera to the home position.
10.Auto scan: Click to run the selected autoscan.
11.Aux: Click to open the aux menu, where you can set up Presets, Tours, Patterns, and

Auto Scans.

21.2.1 Presets

Presets will save a camera position for quick retrieval.

To add presets:

1. Click to open the aux menu.
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2. Click the Preset tab.

3. Enter the number of the preset you want to create under Preset.
4. Move the camera to the desired position and click Set.

To go to a preset:

• Under No., select the number of the preset you would like to go to and click .

21.2.2 Tours

Tours will cycle through a set of presets.

To create a tour:

1. Click to open the aux menu.

2. Click the Tour tab.

3. Under Patrol No., select the tour you would like to configure.
4. Under Preset, select a preset you would like to add to the tour.
5. Click Add Preset.
6. Repeat steps 4 and 5 to add additional presets to the tour.

NOTE

Click Del Tour to clear all presets from a tour.

To run a tour:

• Under No., select the number of the tour you would like to go to and click .

21.2.3 Pattern

Patterns automatically cycle the camera between two positions.

To create a pattern:

1. Click to open the aux menu.
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2. Click the Pattern tab.

3. Under Pattern, enter the pattern you would like to configure.
4. Move the camera into the desired start position and click Begin.
5. Move the camera into the desired end position and click End.

To run a pattern:

• Under No., select the number of the pattern you would like to go to and click .

21.2.4 Auto Scan

An auto scan automatically cycles between a left and right point.

To create a new auto scan:

1. Click to open the aux menu.

2. Click the Border tab.

3. Move the camera into the desired left position and click Left.
4. Move the camera into the desired right position and click Right.

To run an auto scan:

• Click .
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The system comes with a pre-installed 3.5" SATA hard drive. You can install up to two
hard drives up to a maximum size of 4TB each.

22.1 Installing a Hard Drive

CAUTION

Make sure that the system is OFF and the power cable is disconnected before removing/installing the
hard drive.

To install the hard drive:

1. Insert hard drive screws (4x) on the hard drive and tighten them half way.

2. Power off the system, and unplug all cabling from the system.
3. Remove the rear panel screws (4x). Remove the cover.

4. Place the hard drive over one of the sets of screw slots on the bottom of the system
and then slide the hard drive into place. The SATA connectors on the hard drive
should face the center of the unit.
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5. Turn the system over carefully. Tighten the hard drive screws (4x) to secure the hard
drive.

CAUTION

Hold the hard drive in place when turning the system over to prevent damage to the system.

6. Connect the SATA power and data cable to the hard drive.

7. Replace the cover and cover screws (4x).

NOTE

After installation, you must format the hard drive in order to use it with the system. See 22.3 Format-
ting Hard Drives, page 155.

22.2 Removing the Hard Drive

CAUTION

Make sure that the system is OFF and ALL power adapters have been disconnected before removing/
installing the hard drive.

1. Power off the system, and unplug all cabling from the system.
2. Remove the rear panel screws (4x). Remove the cover.

#LX400022; r.16694/30364; en-US 154



DNR400 Series Hard Drive Installation22

3. Turn the system over and loosen the hard drive screws (4x), but do not remove them.

4. Disconnect the SATA power and data cable from the hard drive.

5. Carefully turn the system over. Slide the hard drive and then lift it out of the system.

6. Replace the cover and cover screws (4x).

NOTE

After installation, you must format the hard drive in order to use it with the system. See 22.3 Format-
ting Hard Drives, page 155.

22.3 Formatting Hard Drives

You must format hard drives before you may use them with the system.

CAUTION

Formatting the HDD erases all data on the hard disk. This step cannot be undone. System settings will
not be erased.

To format the hard drive:
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1. From the Main Menu, click and then click Storage>HDD Manager.

2. Select the hard dive you would like to format and then click Format. Click OK to
confirm.

3. Click OK to save changes. The system will restart to complete the formatting process.
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When a malfunction occurs, it may not be serious and can be corrected easily. The fol-
lowing describes the most common problems and solutions. Please refer to the following
before calling FLIR Technical Support:

Error Possible Causes Solutions

• System is not receiving
power, or is not powering up.

• Cable from power adapter is
loose or is unplugged.

• Confirm that all cables are
connected correctly.

• Confirm that the power
adapter is securely con-
nected to the back of the unit.

• Power switch is set to OFF (

) position.

• Confirm that the power
switch is in the ON (I)
position.

• Cables are connected, but
system is not receiving suffi-
cient power.

• Confirm that the system is
powered on (LED indicators
on the front should be ON).

• If the unit is connected
through a power bar or surge
protector, try bypassing the
bar and connecting the
power directly to the wall
outlet.

• Confirm that there is power
at the outlet:

• Connect the power cable
to another outlet.

• Test the outlet with anoth-
er device (such as a lamp
or phone charger).

• Hard drive is not detected
by the system.

• Hard drive cables are loose
or not properly connected.

• Remove the housing and
check that hard drive cables
are firmly connected.

• There is no hard drive in the
system.

• Open the housing and install
compatible hard drive. Make
sure to format the drive after
installing. For details, see .

• Hard drive is full (0%) and
the unit is no longer
recording.

• Overwrite is not enabled. • From the Main Menu, select

>Setting>Gener-
al>General. Select Overwrite
under HDD Full and click OK.

• There is no picture on moni-
tor/TV after connecting it to
the system.

• Monitor/TV not detected by
system.

• Power off the monitor/TV
and system. Power on the
monitor/TV, and then power
on the system.

• Input channel for system not
selected on monitor/TV.

• On the monitor/TV, select
the input channel the system
is connected to.

• Video cable is loose or has
become disconnected.

• Check the video cable con-
nection to the system and
monitor/TV.
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Error Possible Causes Solutions

• Mouse not detected by
system.

• Mouse cable is not firmly
connected to the system.
Mouse is not connected to
the system.

• Firmly connect the mouse
cable to one of the USB
ports.

• System needs to be reset • Power off the system (dis-
connect power cable). Firmly
connect a USB mouse to
one of the USB ports. Re-
connect the power cable to
the DC 12V port on the rear
panel.

• There is no picture on se-
lected channels / camera
picture is not being
displayed.

• Camera cables are loose or
have become disconnected.

• Check the camera video ca-
ble and connections.

• Disconnect and reconnect
the cable at the system and
at the camera.

• Try moving the camera to an-
other channel or use another
cable.

• The system beeps at startup. • The beep at startup is
normal.

• The system beeps during
motion detection.

• Motion detection is enabled
and the alarm buzzer is
activated.

• Open the Main Menu and

click >Even-
t>Motion>Motion Detect. Un-
check Buzzer for each
channel and click Apply.

• I am not receiving email
notifications.

• Email notification is disabled. • Ensure you have configured
email notification. For de-
tails, see 15.3.5 Configuring
Email Alerts, page 53.

• Send Email setting not en-
abled in Event menu.

• Make sure that Send Email
is enabled for any events
you want to be notified of.
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24.1 System

Operating System Embedded LINUX

Pentaplex Simultaneous View, Record, Playback, Backup,
and Remote Monitoring

Number of Channels 8/16 Channels

24.2 Inputs/Outputs

Video IN 8/16 ch: 8 PoE Video Input

Video OUT No

VGA OUT Yes

HDMI Yes

Audio IN 1 Line IN (RCA) for 2–way audio

Audio OUT 1 Line OUT (RCA) for 2–way audio

USB Port 1 at the back, 1 at the front

Alarm IN 4 Alarm IN

Alarm OUT 2 Alarm OUT

Video Output Resolution 1920×1080, 1280×1024, 1280×720, 1024×768

PTZ Control RS-485, supports Pelco-D and Pelco-P

24.3 Display

Display Split 8 ch: 1/4/8/9

16 ch: 1/4/8/9/16

Live Display Speed 8 ch: 240FPS NTSC, 200FPS PAL

16 ch: 480FPS NTSC, 400FPS PAL

OSD Camera Title, Time, Camera Lock, Motion Detec-
tion, Recording Status

System Navigation USB mouse

Motion Area Setting Adjustable grid (22x18)

Sensitivity Levels 100

Firmware Upgrade Automatic over the Internet & via USB device and
network

User Authority By user group

Time Synchronization Auto time sync by NTP server

24.4 Recording

Compression H.264

Resolution 720P (1280x720), 1080P (1920x1080), 3MP
(2028x1536), 5MP (2560x1920)

Record Rate NTSC

8 ch: 240FPS @ 720P / 1080P / 3MP / 5MP

16 ch: 480FPS @ 720P / 1080P / 3MP / 5MP

PAL

8 ch: 200FPS @ 720P / 1080P / 3MP / 5MP

16 ch: 400FPS @ 720P / 1080P / 3MP / 5MP

Recording Resolution Setting Per camera for different resolutions

Recording Quality Control 6 levels
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Record Schedule By hour, by day, by recording mode, by motion, by
channel

Pre Recording Max. 30 Seconds

Post Recording Max. 5 Minutes

Reliability Watch-Dog, auto-recovery after power failure

Covert Video Yes

24.5 Playback and Backup

Playback Channel 8 ch: 1/4/9

16 ch: 1/4/9/16

Playback Speed Variable Max 16x

Playback Players Backup Player

Search By time & event

Log Search Up to 1,000 lines for motion detected, configura-
tion changes, connects/disconnects and video
loss

Audio Play Yes (audio camera required)

24.6 Storage & Archive

Storage 8/16 ch: Up to 2 HDD’s (SATA)

Maximum Capacity 8/16 ch: Up to 2x4TB

Backup Media USB flash drive & HDD

Backup File Format DAVor ASF file

24.7 Connectivity

Cloud Connection FLIR Cloud™

Supported Operating Systems Windows™
Mac OSX

Remote Software Client Software (PC/Mac)

Email Notification Text with snapshot

Instant Smart Phone & Tablet Support iPad®, iPhone®, Android™

DDNS Free FLIR DDNS

System Configuration Full setup configuration over network

Ports Programmable by user

Network Protocol HTTP, IPv4/IPv6, TCP/IP, UPNP, RTSP, UDP,
SMTP, NTP, DHCP, DNS, PPPOE, DDNS, FTP, IP
Filter

Network Interface 10/100/1000Mbps, RJ-45

Network Bit Rate 200Mbs total

48~8192kbps per camera

IP Cameras Supported FLIR, Digimerge, Panasonic, Sony, Dynacolor,
Samsung, AXIS, Arecont, Bosch, Canon, Honey-
well, Pelco, Panasonic, Vivotek

24.8 General
Power Consumption Approx. 20 watts (No HDD Installed)

Supply Voltage 100VAC-240VAC, 50/60Hz

Total PoE Power Output (across all channels) 120W (Max 25W per Camera)
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Unit Weight 2.0kg / 4.4lbs

Dimensions (W x H x D) 267mm x 203mm x 46mm / 10.5” x 8.0” x 1.8”

Operating Temperature 14° ~ 131° F / –10° ~ 55° C

Humidity 10 ~ 90% RH

24.9 Recording Resolution (Pixels) & Speed (FPS — Frames per second)

Model FPS
720P

1280x720

1080P

1920x1080

3MP

2028x1536

5MP

2560x1920

8 ch
Total 240 240 240 240

Per channel 30 30 30 30

16 ch
Total 480 480 480 480

Per channel 30 30 30 30

As our products are subject to continuous improvement, FLIR Systems, Inc. and its sub-
sidiaries reserve the right to modify product design, specifications, and prices without no-
tice and without incurring any obligation. E&OE
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This equipment has been certified and found to comply with the limits regulated by FCC,
EMC, and LVD. Therefore, it is designated to provide reasonable protection against inter-
ference and will not cause interference with other appliance usage.

However, it is imperative that the user follows the guidelines in this manual to avoid im-
proper usage which may result in damage to the unit, electrical shock and fire hazard
injury.

In order to improve the feature functions and quality of this product, the specifications
are subject to change without notice from time to time.

25.1 FCC Class A Notice

This equipment has been tested and found to comply with the limits for a Class A digital
device pursuant to Part 15 of the FCC Rules. These limits are designed to provide rea-
sonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio fre-
quency energy and, if not installed and used in accordance with the manufacturer’s in-
struction manual, may cause harmful interference with radio communications. Operation
of this equipment in a residential area is likely to cause harmful interference, in which
case you will be required to correct the interference at your own expense.
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